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Introduction
This manual describes the Venable Windows Software that is part of Venable’s
complete frequency response modeling and measurement system.
This manual is provided in printed form with the hardware Analyzer, in electronic form in
the software and in electronic form on the download site. The latest version of this
manual can always be found on Venable’s download site beside the current software
installation package. The version in the current software installation can be reached
using the menu item Help Æ Venable Manual.
The installation portion of this manual covers both the hardware and software setup.
The Software works with a number of different hardware models of Frequency
Response Analyzers. Separate licenses must be obtained from Venable for each type
of Analyzer the Software will work with. A separate “Venable type Software” shortcut is
installed in the Windows “Start>>All Programs” menu for each licensed type.
The Software adapts to the differences between Analyzers by showing different
Analyzer Control dialogs and making minor changes in other dialogs. The main
Software Window will display the current licensed type as part of the window title in the
title bar.
This manual will point out the differences between Analyzer types where it matters.
Type specific screenshots of several dialogs are given; please look at the information
relevant to the type of Analyzer you are working with.
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System Overview
The Venable Windows Software in combination with a supported Frequency Response
Analyzer (FRA) is a complete frequency response modeling and measurement system.
The hardware portion consists of a FRA, which is used for making measurements of
gain, phase, and voltage versus frequency and various accessories for coupling the
FRA to the electrical, mechanical, or thermal system under test. Supported FRA’s are
the following 1 . The list is grouped by Software license type:
•
•
•
•
•
•
•
•

350 license type supporting Venable models 350a, 350b, 220 and 250
3120 for Venable model 3120
3215 for Venable model 3215
3225 for Venable model 3225
3235 for Venable model 3235
3577 for Agilent (HP) 3577
4000 for a Venable Series 43xx/63xx/74xx/88xx/350c System
5000 for a Venable Series 51xx System

The FRA’s are controlled in one of two ways:
1. Through a standard USB cable using drivers from the Keysight IO Libraries Suite,
version 18.1 or later (Windows XP is not supported).
(For Windows XP users, Use Venable Software version 5.4 and version 17.1 of
the Keysight IO library drivers)
2. Through a National Instruments GPIB board using version 17.6.0 or later of the
National Instruments ni488.2 drivers (Windows XP not supported).
(For Windows XP users, Use Venable Software version 5.4 and version 2.8.1 of
the ni488.2 drivers)
The software portion runs on any personal computer using Microsoft Windows 7, 8 or
10, 32-bit or 64-bit.
This software also contains a simple spice-like modeling program for modeling the AC
frequency response of circuits. Model results and test results are in the same format
and can be displayed simultaneously for easy comparison. Compensation amplifier
synthesis software lets the user achieve the exact feedback loop bandwidth and phase
margin desired on the first try. “File Math” software allows any kind of mathematical
function on any one or two transfer functions.

1

The older Venable 260 FRA is not supported by this Venable Windows Software. The Model 260 is
controlled with a DSP card using a serial interface and only works under Windows 95/98 with an older
version of this software.
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Data can be saved, recalled, and printed in the form of graphs on any Windowscompatible printer in black-and-white or color if the printer has that capability. Graph
types supported are voltage vs. frequency (log-log), gain and phase vs. frequency
(semi-log), reactance vs. frequency (log-log with lines for constant capacitance and
inductance), and Nyquist (log outside of the unity gain circle and linear inside the unity
gain circle).
The Venable software is protected against illegal copying and use. In order to run, first it
must be activated. On installation you are prompted for the Software Serial Number
given to you by Venable and a Wizard walks you through the steps to activate it.
New Features of the Venable System Version 5.5.0 Software
•
•

National Instruments driver support is updated to version 17.6 of the NI GPIB
drivers.
Keysight IO Libraries driver support is updated to version 18.1.

New Features of the Venable System Version 5.4.0 Software
•

Fixed support to display RLC version 4.4 graphs

New Features of the Venable System Version 5.3.1 Software
•

The software adds a model 350b operating mode for our newest analyzers to
provide operation identical to the legacy Venable 350 analyzers. This function
enables continuous sine wave output through a measurement sweep.

New Features of the Venable System Version 5.3.0 Software
•

The software adds support for analyzer model 5140.

New Features of the Venable System Version 5.2.1 Software
•

The software adds support for analyzer models 7405, 7420 & 7440.

New Features of the Venable System Version 5.2 Software
•

The software adds support for analyzer models 8805, 8820 & 8840.

New Features of the Venable System Version 5.1.4 Software
•

The software has voltage limit warnings added for the Venable Series
43xx/63xx/350c System analyzers. When Input and Output Impedances are
changed, the analyzer can be severely damaged at much lower voltages.

New Features of the Venable System Version 5.1 Software
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•

The software has been updated to work with the USB interface on the Venable
Series 43xx/63xx/350c System analyzers.

New Features of the Venable System Version 5.0 Software
Several new features have been implemented in the Venable System Version 5.0
Software:
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The software has been updated to work with the newly introduced Venable
Series 43xx/63xx/350c System analyzers.

•

The software now works with Windows 7 32bit and Windows 7 64bit.

•

The software now works with Windows 8 32bit and Windows 8 64bit.

•

Software Serial Numbers now license individual PCs replacing the separate Site
Codes. The license activation process has been revamped to reduce errors.
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Installation Procedure for use with USB Interface
This is the step-by-step software and hardware installation procedure for our USB
controlled analyzers.
Note: Use of the USB interface requires the Venable analyzer to be running
application firmware version 2.0 or later.
1. If the National Instruments GPIB drivers are installed on your computer, check to
see if the National Instruments VISA driver is installed. If the NI VISA driver is
installed, you will need to uninstall it before installing the Keysight drivers. Use the
windows control panel -> programs function to check for NI VISA installation.
2. Close all your programs and insert the Venable installation disk into your CD-ROM
drive. The CD should auto-run and the installation window should open up,
otherwise browse the CD with Windows Explorer and double-click on
VenableInstaller. Once the installer menu opens up, click on the Install button for
the Keysight IO libraries Suite. Follow the instructions and install using “typical
settings” option.
3. Install the Venable Windows software.
Note: Manually uninstall any versions older than 4.1.8 of the Venable Software.
Versions 4.1.8 and 5.x will be automatically replaced.
Click on the Install button for the Venable Software. Make sure you have your
software serial number at hand and follow the instructions.
The Venable software is protected against illegal copying and use. In order to run, it
must be activated by a Licensing Wizard program. On installation, this program is
accessible from Start -> All Programs -> Venable Software License. After you
activate your first license, this shortcut is replaced by a shortcut to the Venable
Software for that type of license; in this case you can start the Venable Software and
choose menu item, Help -> Licenses, then press the Change License button.
Manuals for the Venable software, Manual.pdf, and the Licensing Software,
LicenseManual.pdf, are included in the installation directory. These manuals are in
Adobe portable document format (pdf) and are compatible with Adobe Acrobat
Reader version 6.0 and above. An installation program for Adobe Acrobat Reader
can be downloaded at. From the Venable software program you can open the
manual using the menu item, “Help -> Venable Manual”; similarly from the Venable
Licensing Software, you can open the licensing manual using the menu item, “Help > License Manual”.
If you need to uninstall the software for any reason, use Add/Remove Programs and
choose the uninstall option.
05/21/19
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4. Connect a standard USB cable to the analyzer. Plug the other end of the USB cable
into a USB port on the PC. Turn on the Venable FRA analyzer.
5. Set the software settings. Open the Venable System Software by selecting: Start
Menu>>Programs>>Venable type Software. Select View from the program pulldown menu and click on Settings. Select the Interface Name from the pulldown and
set it to USB. Select the FRA Model Number from the pulldown and set it to your
model of analyzer. Next, enter the serial number of the analyzer into the box for
FRA Serial Number.

Venable Settings Window for 63xx/43xx/51xx/74xx/88xx/350c

When you shutdown the application, the values will be saved into the windows
registry.
6. If any problem occurs with the Venable software attempting to communicate to the
analyzer, open the Keysight Connection Expert utility. The Keysight Connection
Expert should automatically perform a verification of any new connections and the
analyzer should appear in the list under the USB interface with a green check box. If
the instrument is checked with a red X, cycle the power on the analyzer to reset the
connection.
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Installation Procedure for use with GPIB Adapter
This is the step-by-step software and hardware installation procedure for our GPIB
controlled analyzers.
1.

Before installing the GPIB adapter in the PC you plan to use, install the National
Instruments GPIB driver software, version 17.6 or later. Close all your programs
and insert the National Instruments CD into your CD-ROM drive. The CD should
auto-run and the installation window should open up, otherwise browse the CD with
Windows Explorer and double-click on Setup. Left-click on Install NI-488.2
Software for Windows. Follow the instructions. You need only the default
installation of the software and you do not need to enable DOS.

Note: Always install the GPIB driver software FIRST. The GPIB adapter won’t
work otherwise. You will have to uninstall the software and the adapter and then
re-install them in the correct order.
2.

Turn the computer off, then install the National Instruments GPIB adapter in the
computer. It is available in ISA, PCI, GPIB-USB, and PCMCIA versions. The
software for all versions is the same. When you turn the computer back on, it
should recognize the GPIB adapter as part of the boot-up process. The NI-488.2
Getting Started Wizard window will open up in the lower right corner of your
screen. If you want to double-check your installation, left-click on “Verify your
hardware and software installation”. If the installation is correct, your status will be
passed in the NI-488.2 Troubleshooting Wizard window when the testing is done.
Click on Exit when your status is verified. Skip the rest of the steps by closing the
Getting Started window. These steps are not needed.

3.

Install the Venable Windows software.
Note: Manually uninstall any versions older than 4.1.8 of the Venable
Software. Versions 4.1.8 and 5.x will be automatically replaced.
Close all your programs and insert the Venable installation disk into your CD-ROM
drive. The CD should auto-run and the installation window should open up,
otherwise browse the CD with Windows Explorer and double-click on
VenableInstaller. Once the installer menu opens up, click on the Install button for
the Venable Software. Make sure you have your software serial number at hand
and follow the instructions.
The Venable software is protected against illegal copying and use. In order to run,
it must be activated by the Licensing Wizard program. On installation, this program
is accessible from Start -> All Programs -> Venable Software License. After you
activate your first license, this shortcut is replaced by a shortcut to the Venable
Software for that type of license; in this case you can start the Venable Software
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and choose menu item, Help -> Licenses, then press the Change License button.
Manuals for the Venable software, Manual.pdf, and the Licensing Software,
LicenseManual.pdf, are included in the installation directory. These manuals are in
Adobe portable document format (pdf). An installation program for Adobe Acrobat
Reader can be downloaded at www.adobe.com. From the Venable software
program you can open the manual using the menu item, “Help -> Venable Manual”;
similarly from the Venable Licensing Software, you can open the licensing manual
using the menu item, “Help -> License Manual”.
If you need to uninstall the software for any reason, use Add/Remove Programs
and choose the uninstall option.
4.

For hardware models 350a/350b/220/260 and HP3577, verify the hardware GPIB
address is 8.
Verify that address 8 is set on the 250 and 350 analyzers by locating the 8-position
DIP switch module on the rear panel of the analyzer. The upper 3 switches should
always be at 0. All ADDRESS switches should be at 0 except the fourth from the
bottom, which should be 1. This sets the analyzer to address 8 on the IEEE-488
bus. On the newer 350b analyzers address weights instead of switch numbers are
printed on the DIP switch module as seen below.
1
2
3
4
5

20
21
22
23
24

1
2
4
8
16

Address weight when switch is set to one
The 220 system has no rear panel switches and you must turn on the analyzer to
verify the GPIB address is set to 8. After the analyzer completes start up selfcalibration, press the spot set up button above the analyzer power switch. Keep
pressing the spot set up button to scroll through the analyzer settings until you
reach the address setting. To set the address to eight, press 8 on the front panel
and one of the three enter keys. The analyzer ‘s GPIB address is now set to 8.
Verify that GPIB address 8 is set on the HP3577 by turning on the analyzer. The
HP3577 has no address switches and you must turn on the analyzer to verify the
GPIB address. After the power up self-tests, press the button marked LCL under
the SYSTEM menu on the front panel of the analyzer. Press the ANALYZER
ADDRESS button on the display. Type in the appropriate address on the keypad, if
necessary, and press the ENTER button on the display. The GPIB address is set
and stored.
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5.

Verify the software settings are correct. Open the Venable System Software by
selecting: Start Menu>>Programs>>Venable type Software. Select View from the
program pull-down menu and click on Settings. Ensure the GPIB address is set at
8, which is the factory default address on your analyzer. Make sure the selected
interface name is set to the default GPIB0. In the special case where there is more
than one GPIB adapter or interface installed on the computer, the interface name
may have to be changed in order to select the correct adapter to communicate with
the analyzer. Click on OK and select Actions from the program pull-down menu
and open the Analyzer Control Menu. Click on the Take Data at Start Freq button
to enable the new address setting. When you shutdown the application the new
address will be stored in the VenPreftype.txt file.

Venable Settings Window for series 63xx/43xx/51xx/74xx/88xx/350c

Venable Settings Window for 3120/3215/3225/3235
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Venable Settings Window for 350a/350b/220/250
The Venable Settings window also allows the user to select the default chart to be
displayed when the program is opened.
The Venable Settings window for 350a/350b/220/250 allows the user to switch between
the 3 models to get the model specific Analyzer Control Menu dialog.
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“Sanity check” – Measure the Output of the Oscillator
After you have connected the hardware and turned the power on and installed the
software, a natural question that comes up is “Does it work?” To answer that question,
just follow these simple steps:
1. Hook up the BNC to Mini-grabber cables that come with the system to the oscillator
output and to each of the inputs of the FRA (for 3215/3225/3235 hook up to the main
input marked with a + of channel 1 and channel 2). Connect all the black
Minigrabbers together and all the red Minigrabbers together.
2 Open the Venable Windows software and click on the Analyzer Control
Icon on the toolbar, the next-to-last icon just left of the “?” icon. (If you
leave the mouse on the icon for a second, it will say “Analyzer Control”.)
3. Set the Start Frequency to 10 Hz. For model HP3577 set the AC Volts Out to 100.2
Vrms; for other models set the AC Volts Out to 1 Volt peak. For models
350a/350b/220/250 and 3120 set the waveform to Sine. Click the Take Data at Start
Frequency. The grayed out windows below the Stop Taking Data button on the right
side of the Analyzer Control Menu should then read the following values based on
analyzer type:
Analyzer type
3215/3225/3235, 3120
350a/350b/250
220
HP3577
63xx/43xx/51xx/74xx/88xx/350c
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Frequency
(Hz)
10
10
10
10
10
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2 or 3 channels
(Vrms)
0.707
0.707
1
100 mVrms
0.707

Gain
(dB)
0
0
0
0
0

Phase
(degrees)
0
0
0
0
0

Data taken by the analyzer will be displayed in the Communication with Analyzer
window as shown in the type specific figures below.

Series 63xx/43xx/74xx/88xx/350c Analyzer Control Menu connected to a Model 350c.

3215/3225/3235 Analyzer Control Menu with two channels measuring the oscillator output.
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350a/350b/220/250 Analyzer Control Menu with all three channels measuring the oscillator output.

3120 Analyzer Control Menu with two channels measuring the oscillator output.
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HP3577 Analyzer Control Menu with two channels measuring the oscillator output.

If this all works, the system is hooked up and working properly.
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Tutorial No.1 – Measure an RC Low-Pass Filter Transfer Function
If the “Sanity check” worked out but you still are not convinced, try this as a real-life
application of a frequency response analyzer:
1. Take a resistor and capacitor you know the value
of and solder them in series. Using the same BNCMinigrabber cables as before, connect both the
oscillator output and the main input (marked with a
+ for models 3215/3225/3235) of channel 1 across
both parts with the black (return) lead connected to
the capacitor. Connect channel 2 across the
capacitor with the black (return) lead connected the same place as the other two
black leads. Calculate the corner frequency of the filter from the formula f=1/2πRC.
If you don’t want to do that much work, use a 1k resistor and a 0.1 μF capacitor and
the corner frequency will be 1.6 kHz.
2. Again click the Analyzer Control Icon
to open the analyzer control window.
Set the sweep from approximately 2
decades below the corner frequency
to approximately 2 decades above
the corner frequency (10 Hz to 100
kHz if you use 1k and 0.1 μF.
For 3215/3225/3235, select Log
Sweep, 10 Steps per Decade, 1.414
volts peak AC or 1 Vrms, 0 volts DC,
Integration Time: Medium, and 0
Delay Time.
For 350a/350b/220/250, select Log Sweep, 10 Steps per Decade, 1.414 volts peak
AC or 1 Vrms, 0 volts DC, sine wave, 1-second integration or 10 Hz Bandwidth, and
0 delay time.
For 3120, select Log Sweep, 10 Steps per Decade, 1.414 volts peak AC or 1 Vrms,
0 volts DC, sine wave, Integration Time: Medium, and 0 Delay Time.
For HP3577, select Log Sweep, 10 Steps per Decade, 100 mVrms Bandwidth: Auto,
Default Delay Time, Input Impedance: 1 Meg, and Attenuation: 20dB.
For 43xx/63xx/74xx/88xx/350c, select Log Sweep, 10 Steps per Decade, 1.414 volts
peak AC, 0 volts DC, sine wave, 50 Ohm output impedance, 1-second integration, 0
delay time and 1 Mohm input impedance.
Click on Run Sweep.
05/21/19
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3. The Data Set Properties window will open,
as shown below giving you the choice of
output node number (channel number), input
node number (channel number), and scale
factor. The default settings Output Node=2,
Input Node=1, and Scale Factor=1 are
correct for this measurement. When you
have selected the desired variable values,
click on “Close”. The window will close and
the analyzer will start taking data over the
selected frequency range

4. The sweep will start. The analyzer control
window will not minimize automatically. You
may want to move or minimize it so you can
see the plot of the data being taken in real
time. The resulting gain plot should be flat at
0 dB out to the corner frequency, then fall at
a -20 dB per decade slope thereafter. The
phase should be 0 degrees at low frequency,
-45 degrees at the corner, and
asymptotically approach -90 degrees at high
frequency. If this works, you can be certain
that the equipment is connected and
functioning properly.
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Measured transfer function of
low pass R-C filter

Tutorial No.2 – Model of an RC Low-Pass Filter Transfer Function
As a simple example of how the modeling portion of the software works, an easy thing
to do is model the transfer function of the low-pass RC filter corresponding to the test in
Tutorial No. 1. If you actually did the test, you can overlay the test and model data to
see how close you came.
1. To start the process, click on the “Error Amps and Circuits” Icon, the one
just to the left of the Analyzer Control Icon. When that window opens, select
the “Circuit (CKT) Model” tab. If there is anything in the text box, delete it
and type in the text below:
2.
V001
R101
R 1 2 1K
C 2 0 0.1U

3. For the record, the first two lines represent a
fixed voltage source with a magnitude of 1 volt
and an internal resistance of 1 ohm, connected
from node 1 (the input) to node 0 (ground). The
third line represents a 1k resistor connected
from node 1 (the input) to node 2 (the output).
The final line, line 4, represents a capacitor
connected from node 2 (the output) to node 0
(ground) with a value of 0.1 microfarads. The
analysis will be done from node 1 to node 2.
The internal resistance of the source does not
matter since it only changes the absolute
magnitude of the voltage on nodes 1 and 2, not the ratio.
4. After entering the above net list, click the button
labeled “Go to Circuit Analysis Tab”. Select the
desired Max and Min Frequencies (the same
ones you used for the test), the nodes to
analyze (1 and 2), and Log Sweep at 10 Steps
per Decade. When all variables are correctly
entered, click the “Compute AC analysis from
CKT” button. You will be sent automatically to
the “Frequency (AC) Data” tab. An ASCII text
result file will be displayed in Venable Standard
Format, which is 5 columns: Frequency, Node
number, Voltage (volts), Voltage (dB), and
Phase (degrees). There will be a row for each node selected at each frequency.
There is no fixed limit on the size of the circuit or the number of nodes being
05/21/19
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analyzed. The maximum size is dependent on the available memory in your
computer.

5. Click on the “Import into Graph” tab. For
Gain or Impedance Displays, the Data Set
Properties window will open giving you the
choice of output node number, input node
number, and scale factor. Choose Output
Node=2, Input Node=1, and Scale
Factor=1. Once you have selected the
desired variable values, click “Save
Changes” and “Close”. The window will
close and the transfer function of the lowpass RC filter will be displayed on the
graph.
6. If you did the test first, both plots will be on the graph. The test data will be labeled
1-Gain and 1-Phase. The model data will be labeled 2-Gain and 2-Phase. If you
entered the correct values for the R and C, the two sets of data should virtually
overlay each other. The up and down-arrow keys select and toggle through the data
sets displayed on the screen in ascending and descending order, respectively. You
can change the properties of a data set by using the up and down-arrow keys to
select the data set and then pressing the short cut key “D” to open the Data Set
Properties window. The number of the data set you selected will appear in the Data
Set scroll box. You may select another data set and it’s properties by clicking on the
Data Set scroll box arrow and selecting that data set number. You can document
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any data set by entering a description in the text window. Other data set properties
you may alter are scaling, channel ratio, gain or phase color, visibility or you may
delete a data set. When you are done click “Save Changes” and “Close”. The data
can now be documented for printing. Select a data set you wish to display
information on and then press the short cut key “T”, an editable text box will open
(this is the same text window that is displayed in the Data Set Properties window).
You may also wish to display the values of the gain/phase data at a particular
frequency with a slide bar. Press the short cut key “B” to create a slide bar, then leftclick and drag the slide bar to the frequency of interest. A particular data set can
have multiple slide bars if needed. The Data Description and Slide Bar windows
may also be moved anywhere on the chart that is convenient before printing.

RC Low Pass Filter Model Data Plotted Over Test Data
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Toolbars and Drop-Down Menus

The toolbar is shown above. The nine icons on the left are Windows standard icons,
New (plot), Open (plot file), Save, Cut, Copy, Paste, Delete, Print, and Print Preview.
The seven icons on the right are (left to right):
1)
2)
3)
4)
5)
6)
7)

Add slide bar
Add Data Description text box
Add Graph Description text box
Transfer Function Math Menu
Error Amps Synthesis and Circuit Analysis Menu
Analyzer Control Menu
Help

To see the functions available on the drop-down menus (File through Help), click on the
Help menu and then click on Venable Help or click the Help icon. You can click on the
individual menus when the Help window opens. An index of these is shown below:

The user can press the F1 key for context sensitive help on an active window, menu, or
dialog box. The help window will open at the appropriate topic.
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Keyboard and Mouse Shortcuts
Like any Windows program, you can hold down the Alt key and hit any underlined letter
to activate that pull-down menu. Many of the standard Windows Edit Menu control key
functions also work, for example:
Ctrl+A
Ctrl+C
Ctrl+N
Ctrl+O
Ctrl+P
Ctrl+S
Ctrl+V
Ctrl+X

Select All Data Sets
Copy Data Set
New Plot File
Open Plot File
Print Plot File
Save Plot File
Paste Data Set
Cut Data Set

Additional Edit Menu keyboard functions have also been created to manipulate data
sets on the plot.
Del
Ctrl+L
Ctrl+Del
Up-arrow key
Down-arrow key

Delete (with the option to hide or cancel) Data Set(s)
Show All Data Sets
Hide Data Set(s)
Select the first Data Set if none is selected and/or toggle
through the displayed Data Sets in ascending order
Select the last Data Set if none is selected and/or toggle
through the displayed Data Sets in descending order

A number of single key commands have been implemented as Venable Software Menu
keyboard shortcuts, for example:
A
B
D
G
H
I
L
M
R
S
T
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Analyzer Control Menu
Add Slide Bar
Data Set Properties
Graph Properties
Toggles Data Set number visibility
Toggles Graph Title visibility
Toggles Graph Legend visibility
Math Menu
Add Random Data
Circuit Analysis and Synthesis Menu
Show Data Text Description
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The Slide Bar has arrow key shortcuts associated with it.
Left or Right-arrow key
Ctrl+ Left or Right-arrow key
Shift+ Left or Right-arrow key

Moves the slide bar left or right between the data points
taken by the analyzer.
Finds the 0 dB crossing point (phase margin) if it exists.
Finds the 0 degree, +/-90 degree, or the +/- 180 degree
phase points (inductance, resistance, capacitance, or
gain margin) if they exist.

The Analyzer Control Menu has keyboard shortcuts associated with it.
Up or Down-arrow key

Page Up or Page Down key

Increments the AC Volts Out control up or down
respectively by the number of decibels entered in the
AC Out Step Size control text box.
Moves the DC Volts Out control up or down
respectively by 10mV increments.

Besides the keyboard shortcuts, there are mouse short cuts.
1)
2)
3)
4)

Click on any open area of a graph to deselect all data sets.
Click on any point of any data set to select it.
Ctrl+click to select multiple data sets.
Shift+click on a first and last data set to select the first and last data sets and all
the data sets in between.
5) Double click on any point of any data set to open the Data Set Properties window.
6) Double click on an open area of the graph to open the Graph Properties window.
7) Right-click when a single data set is selected or when a text window is active to get
the pop up-menu for Show All, Select All, Copy, Paste, Hide, and Delete.
8) Click and drag any window or text box to move it.
9) Click and drag the side or corner of a text box to resize it.
10) Click and drag a Slide Bar to move it.
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Measuring a Feedback Loop Transfer Function
The classical way to measure a feedback loop transfer function is to break the loop at
some point, terminate the input with the output impedance, terminate the output with the
input impedance, drive a small AC signal into the input and measure the ratio of the
output to the input. In SPICE analysis, the input is frequently set at 1 volt and the output
voltage is then plotted directly as gain since the denominator of the ratio has a constant
value of 1. In real life, this measurement approach is virtually impossible since the loop
gain is usually very high at low frequency and it is difficult to keep the input stable
enough to prevent the output from swinging wildly from limit to limit.

Classical Method

Venable Method

We avoid this difficult measurement situation by finding a place where the loop is
confined to a single path (also a requirement in the classical method) and a place where
the signal comes from a low-impedance point and drives a high-impedance point. This
impedance condition minimizes the error caused by not properly terminating the input
and output. We then insert a small resistor into the feedback loop (small compared to
the input impedance of the loop). Finally, we connect a floating AC source (the output
of a transformer) across the new resistor and drive the primary of the transformer with a
sinusoidal voltage source. This converts the resistor into a floating sinusoidal error
voltage in series with the feedback loop. This voltage modulates the operating point of
the entire circuit.
Ramp
P/S Output
Power
Circuitry

Injection
Point

To Load

V

V2 (Output)

Modulator

PWM Signal
Modulator

Injection
Point

Injection Transformer
Signal
Path

Zf

Injection
Resistor

Oscillator

Zin
DC Reference

R bias

Amplifier

V V1 (Input)

Amplifier

Injection Points

05/21/19

Injection Technique

26

Once the operating point is modulated, it is easy to measure the voltage to ground from
any point in the circuit. The difficult part is that the only signal that matters is the voltage
at the frequency of the injected error voltage, which may be a few millivolts in the
presence of volts of noise. That is where our superior Frequency Response Analyzer
comes in. It uses true Fourier Integral analysis (as opposed to the less-accurate Fast
Fourier Transform) to accurately measure amplitude and phase of small signals buried
in large amounts of noise. Loop gain is the ratio of the voltage out of the circuit to the
voltage into the circuit. The amplitude of the various voltages varies widely with
frequency, but the absolute values are not important, only the ratio and relative phase
angle.
In the rare case where the impedance ratio of input to output is not sufficiently high, a
correction factor can be applied to the data to correct for the impedance condition.

A
A

actual

+

measured

=
1 +

Z out
Z in

Z out
Z in

There is also a “dual” of the voltage injection method that is useful when the input
impedance is much lower than the output impedance. This involves injecting a current
into the loop instead of a voltage and measuring the ratio of the currents on either side
of the injection point instead of the voltage. These two test techniques are shown in the
figures below, and the current injection technique is used in one of the injection point
examples.

Voltage Mode Injection
Use when Zin >> Zout
Gain = CH2/CH1
This is the normal injection method

05/21/19

Current Mode Injection
Use when Zin << Zout
Gain = CH2/CH1
“Dual” of normal method
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Here is a step-by-step description of how to measure a feedback loop transfer function:
1. Find a place in your circuit where the loop is confined to a single path, comes from a
low impedance, and drives a high impedance. In a power supply, the most reliable
place that meets these criteria is the point where the resistor or network (labeled Zi
in the figure below) connects to the output of the power supply, typically a largevalue electrolytic capacitor.

Injection in top of feedback string.

Injection between amplifier and modulator.

Inject in feedback of error amplifier.
Always available but usually noise
sensitive. Also works on circuits with
TL431’s and optocouplers.
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Injection in circuits using TL431.
Make sure injection includes both the “fast
loop” through the diode and the “slow loop”
through the resistive divider string.
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Current injection works in many difficult measurement situations. This method
requires two current loops and two current probes but no resistor inserted in the
circuit. Gain is determined by the ratio of two currents instead of the ratio of two
voltages. A high-value resistor (typically 10k) is used to couple the oscillator output to
the test point between the two current probes. Use the DC offset capability of the
oscillator to bias the DC level to match the common mode voltage of the error
amplifier, usually 2.5 volts, so the DC operating point of the circuit is not disturbed.

2. At the injection point, lift the resistor or network off the printed circuit board and
insert a low-value resistor between the network and the output bus. The preferred
value of this injection resistor is 100 ohms. Lower resistance values can be used,
even down to 1 ohm, but the signal levels and the bandwidth of the injection
transformer may suffer. You can judge the effect for yourself by noting the quality of
the data, especially the data at frequencies far below or above the loop crossover
frequency. On future designs, think about designing the injection resistor in as a
permanent part of the circuit. The cost is negligible and it allows you to perform a
loop frequency response test any time you want to.
3. Three points are necessary to measure loop gain: the two sides of the injection
resistor and signal ground. The connection used to measure signal ground should
preferably be very near the ground of the DC reference voltage, typically the ground
pin of the PWM control chip. If these three points are not all accessible with
Minigrabber clips, solder test points to the circuit as required.
4. Using three of the BNC-BNC cables provided, connect the Oscillator, Channel 1,
and Channel 2 of the Frequency Response Analyzer to the corresponding three
BNC connectors on a Bode Box Model 200-002 injection transformer.
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5. Using the black, brown, and red Banana-Minigrabber cables provided, connect each
banana plug end to the correspondingly colored banana jack on the same Bode Box
Model 200-002 injection transformer.
6. Connect the black Minigrabber to signal ground near the ground of the reference
voltage. This point must be within rated signal ground to chassis ground voltage of
your particular analyzer.
7. Connect the brown Minigrabber to the point where the injection resistor ties to the
error amplifier input resistor or network. This voltage must be within rated input to
signal ground voltage of your particular analyzer.
8. Connect the red Minigrabber to the point where the injection resistor ties to the
power supply output bus (or equivalent point in your circuit). This voltage must be
within rated input to signal ground voltage of your particular analyzer.

9. Turn your circuit on and make sure it is operating properly.
10. A highly recommended step is to connect a two-channel oscilloscope to the same
signals that Channel 1 and Channel 2 are connected to. This will allow you to
monitor the amount of signal injected into the loop and determine if there is any
clipping or distortion of the sinusoidal injection signal. The theory behind this
measurement requires that the output be continuously and linearly proportional to
the input. If this is not true, the results will not be valid.

Distorted sine wave indicates overdrive.
05/21/19

Undistorted sine wave is desired.
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11. Open the Venable software and click on the Analyzer Control icon. Set the variables
as desired.
Typical values for models 3215/3225/3235 are:
Start Frequency
10 Hz
Stop Frequency
90 kHz (10-20% less than your switching frequency)
Log Sweep
10 Steps/Decade
AC Volts Out
1
DC Volts Out
0
Input Coupling
AC
Integration Time
Slow
Delay Time
0 Sec
Servo
Off
AC Out Step Size 10 dB
Max AC Volts Out 10 Volts peak
Channel Ratio
CH2/CH1
Max Gain Change Unchecked
Max Phase Change Unchecked
Typical values for models 350a/350b/220/250 are:
Start Frequency
10 Hz
Stop Frequency
90 kHz (10-20% less than your switching frequency)
Log Sweep
10 Steps/Decade
AC Volts Out
1
DC Volts Out
0
Waveform
Sine
Integration Time
1 Sec
Delay Time
0 Sec
Servo
Off
AC Out Step Size 10 dB
Max AC Volts Out 10 Volts peak
Channel Ratio
CH2/CH1
Max Gain Change Off (unchecked)
Max Phase Change Off (unchecked)
Typical values for model 3120 are:
Start Frequency
Stop Frequency
Log Sweep
AC Volts Out
DC Volts Out
Waveform
Input Coupling
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10 Hz
90 kHz (10-20% less than your switching frequency)
10 Steps/Decade
1
0
Sine
AC < 55V
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Integration Time
Medium
Delay Time
0 Sec
Servo
Off
AC Out Step Size 10 dB
Max AC Volts Out 10 Volts peak
Channel Ratio
CH2/CH1
Max Gain Change Off (unchecked)
Max Phase Change Off (unchecked)
Typical values for model HP3577 are:
Start Frequency
10 Hz
Stop Frequency
90 kHz (10-20% less than your switching frequency)
Log Sweep
10 Steps/Decade
AC Volts Out
317 mVrms
Waveform
Sine
Bandwidth
1 Hz
Delay Time
Default
Averaging
Off
Input Impedance
1 Meg
Attenuation
20dB
Servo
Off
AC Out Step Size 10 dB
Max AC Volts Out 1.259 Vrms
Channel Ratio
CH2/CH1
Max Gain Change Off (unchecked)
Max Phase Change Off (unchecked)
Typical values for series 63xx/43xx/51xx/74xx/88xx/350c are:
Start Frequency
Stop Frequency
Log Sweep
AC Volts Out
DC Volts Out
Waveform
Output Impedance
Integration
Integration Time
Delay Time
Input Impedance
Servo
AC Out Step Size
Max AC Volts Out
Option
Circuit Under Test
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10 Hz
90 kHz (10-20% less than your switching frequency)
10 Steps/Decade
1
0
Sine
50 Ohm
Time
1 Sec
0 Sec
1 Mohm
Off
10 dB
10 Volts peak
Off
DC
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Channel Ratio
CH2/CH1
Max Gain Change Off (unchecked)
Max Phase Change Off (unchecked)

12. Click on the “Take Data at Start Freq”
button. There should be
communication with the analyzer,
with the data showing up in the text
box in the lower-left corner of the
Analyzer Control window. The “Gain”
and “Phase” boxes (on the right side
of the window under “Channel Ratio”
should read reasonable values.
13. If everything looks OK, click the “Run
Sweep” button. The system will
automatically sweep from the start
frequency to the stop frequency at the
specified number of steps per
decade. You may want to move or
minimize the Analyzer Control
window so you can see the data
being presented in real time.
14. When the sweep is complete, you
can minimize or close the Analyzer
Control window. The data just taken
will automatically be “selected” and
each data point will show as a black
dot. When you click the right mouse
button, you will see a number of
options you can do with the selected
data set. You can cut, copy, or paste
the data onto another graph, even
one with a different format. You can
add a slide bar. This is a vertical cursor you can move with the mouse. The values
of Gain and Phase can be read directly in the related text box as you move the slide
bar. You can have as many slide bars as you want, on as many data sets as you
want. You can move the text boxes to any desired position. Another option is to
change the data set properties. You can change the output node number, input
node number, scale factor, or color of either curve. You can edit the Data Text
Description, as well as, hide, unhide, delete, or change to a different data set. The
final option is called “Show Data Description” under the View program menu. This
will open a text box keyed to the data set by set number. You can enter any desired
information in the box to document the data set. There can be one box for every
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data set. All text boxes will print as shown on the screen. The Print Preview button
is on the icon bar.
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Measuring a Feedback Loop – Digital Method
With the growing use of digital processors to implement the compensation portion of a
feedback loop, the 88xx series of analyzers provides the means to interface to these
processors to extract the error amplifier and modulator generated values from them.
Connection of the generator and the analog channels remains the same as discussed in
the previous section, “Measuring a Feedback Loop Transfer Function” and should
continue to be used as the guide for measuring the analog portions of the feedback
loop. This will be used to measure the total loop response of the feedback loop and
provide the injection signal into the circuit under test.
Connection to a target
processor is done with the
Digital I/O port using the
cable provided. The
connection consists of an I2C
bus, a sync signal and a
ground. The connections are
color coded as follows:
I2C Data – Yellow
I2C Clock – Green
Sync – Orange/Red
Ground – Black/Grey

Typical Feedback Loop with Digital Controller

A terminal point that is soldered to these signal lines is likely to be needed in order to be
able to attach the Digital I/O port Minigrabbers to establish the communications
interface.
Source code for the target processor is provided with the applications package to be
compiled in with the manufacturers source code. This code will provide the
communications interface for the analyzer. Refer to the Application Notes provided with
the package for the specifics on use of this
code with your particular processor.
After the processor has been loaded with
the software that includes the Venable
supplement compiled in, and the physical
I/O attachments are made to the target
processor, the measurement of the
feedback loop can be started. The Venable
Stability Analysis software can be opened
on the Windows PC. The Analyzer Control
Menu can be accessed from the menu
ribbon. In the center of the menu is a
pulldown labeled “Option”. By selecting the
05/21/19
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“Digital Interface” on the Option list, the digital interface on the analyzer can be enabled
or disabled. The status on the option list will indicate the current state of the option in
the analyzer. After the Digital Interface has been turned “ON”, the Digital Interface
status block on the right side of the menu will no longer be grayed out.
If the communications block shows no errors, the “Take Data at Start Freq” can be
initiated. If everything is functioning correctly, there should be valid measurements
showing in the “CH1” and “CH2” data boxes and the “e” and “u” data boxes of the Digital
Interface block. The Digital Interface Block also includes limiting factors for “e and “u”
that can be set by the user to prevent overdriving the digital stage. These settings act as
a servo-type control to reduce injection amplitude if the stated limits are hit and keep us
within the performance constraints of the target processor. Each can be enabled
separately by checking the corresponding check box.
Once you have performed
a sweep of the feedback
loop, a plot of the digital
data can be accessed in
the usual manner through
the Data Set Properties
window associated a
particular plot. The error
amplifier “e” value is
labeled as node 91 and the
modulator value “u” value is
labeled as node 92.
Digitally Controlled Feedback Loop Measurement
Technique
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Measuring a Modulator (Plant) Transfer Function – Open Loop Method
We use the words “Modulator”, “Plant”, and “Control-to-output transfer function”
synonymously. These terms refer to the gain from the output of the error amplifier to
the output of the system. This gain block typically has a fixed low-frequency gain. High
frequency gain falls off at a -1 (-20 dB/decade) or -2 (-40 dB/decade) slope depending
on the characteristics of the circuit. Because the gain at low frequency (including DC) is
fixed, it is possible to use a DC voltage to bias the operating point to achieve a desired
system output. By superimposing a small AC voltage on the DC bias voltage, the
operating point of the modulator can be varied. The transfer function of this gain block
can then be measured by connecting frequency selective voltmeters (the inputs of the
Frequency Response Analyzer) to the input and output of the circuit and sweeping the
modulation frequency across the desired frequency range. The output of Venable
Analyzers are designed to deliver DC and swept frequency AC voltage simultaneously.
The inputs are designed to measure voltage at the frequency of the output and reject all
other frequencies and DC.
Here is the step-by-step procedure for measuring the control-to-output transfer function:
1. The first step is to set up the circuit to be controlled by the output of the FRA.
There are three ways to do this. If the error amplifier is a high output impedance
transconductance amplifier, the
output can be biased high and the
output of the FRA used directly to
control the operating point. If the
error amplifier has a conventional low
impedance output but has an input
common-mode range at least
equal to the voltage swing
needed in the output to control
the system, the error amplifier
can be wired as a buffer follower.
If the error amplifier has a
conventional low impedance
output and a relatively narrow
input common-mode voltage
range that does not encompass
the entire output voltage swing
required, the error amplifier can
be wired as a gain stage and
there is complete freedom of
operating point. If in doubt, this
third method will work in any
situation. The three methods are shown in the nearby figures.
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2.

The next step is to adjust the DC voltage for the desired output of the system. This
can always be done if the system has a fixed gain at low frequency. It may be
simpler to use a DC lab power supply or a pot across the +5 V reference voltage
from the PWM chip to set the bias voltage initially since they are easy to adjust.

Adjusting operating point with
laboratory power supply.

Adjusting operating point with
pot across 5V reference of PWM chip.

The DC voltage can then be read with a voltmeter and the FRA output DC voltage
pre-set to the approximate operating point. To set the DC output voltage of the
FRA, open the Analyzer Control menu and set the “DC Volts Out” to the desired
value. Then click the “Turn DC Volts ON” button to set the FRA output to that DC
value. Once the approximate operating point is set, it is easy to increment the DC
voltage from the FRA to “tweak” the system output to the desired value. The
buttons next to the DC voltage setting box increment the DC voltage in 10 mV
increments. When the analyzer control window is minimized, the PageUp and
PageDown keys increment the DC voltage in 10 mV increments as they did in our
DOS software. The DC output voltage is not affected by the sweep.
3.

If you haven’t already done so, connect Channel 1 of the FRA to the input of the
modulator (the error amplifier output) and Channel 2 of the FRA to the output of the
modulator (the system output). Use the furnished BNC-Minigrabber cables unless
the system under test is affected by the capacitance of the cables. If it is, use a
10:1 scope probe on both Channel 1 and Channel 2. (See the section on
calibrating probes in the advanced applications portion of this manual.)

4.

In the Analyzer Control window, set the AC volts to a small number, typically
between 1 and 10 millivolts depending on how much you want to modulate the
operating point. If you are not sure, start low and raise the voltage slowly while
monitoring the amount of modulation you are injecting. When you click the “Take
Data at Start Freq” button, the FRA will output that small signal superimposed on
the DC voltage. The modulator output will be the modulator input multiplied by the
modulator gain, therefore the ratio of output voltage to input voltage is the
modulator gain.

5.

To get the modulator transfer function, click the “Run Sweep” button in the
Analyzer Control window. The measurement system will then automatically sweep
the frequency of the AC portion of the FRA output signal from the start frequency to
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the stop frequency at the specified number of steps per decade and display the
gain vs. frequency and phase vs. frequency data on the graph.
6.

05/21/19

This data can then be used to automatically design the error amplifier
compensation for the desired loop bandwidth and phase margin.
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Measuring a Modulator Transfer Function – Closed Loop Method
The open loop method described in the previous section is the best method for going
directly to the desired system performance without any trial-and-error. Quite often,
however, the loop is already closed and the objective is to “fix” the loop rather than
design it. In this case, the modulation signal is injected as an error voltage in series
with the feedback loop exactly as it is when measuring loop gain (see section on
measuring loop gain).
The principal difference
between measuring the
modulator and measuring the
loop is that the simple
connection where the injection
signal is connected
automatically to the FRA inputs
through internal connections in
the Bode Box injection
transformer is not used. The
Bode Box injection transformer is still needed to inject the signal to vary the operating
point, but separate BNC-Minigrabber or scope probe connections are used to measure
the modulator input and output voltage, just as in the open loop case.
The advantage of measuring the
modulator transfer function while the
system under test is operating closed
loop is that the bias adjustment
procedure described in the previous
section is not needed. The
disadvantage is that the signals are
generally noisier and the accuracy is
not as good, especially at high
frequency.
Servo Control Recommended
The Servo Control dynamically
changes the AC Volts Out to keep an
input channel at a fixed voltage while the analyzer takes data. The Servo Control
compares the input voltage on the monitored channel to the AC Volts In and changes
the AC Volts Out until they are equal. It changes the AC Volts Out by a maximum of AC
Out Step Size. This feature is helpful in preventing the analyzer oscillator from
overdriving the circuit past Max AC Volts Out during a sweep. The recommendation is
to set Servo on the output channel (typically channel 2) at 20 mV to 30 mV and Max AC
Volts Out to your circuit limits below the maximum output of 10 Vpk.

05/21/19

40

Design of a Feedback Amplifier from the Modulator Transfer Function
Once you have measured (or modeled) the modulator transfer function, you can have
the Venable System software design the compensation amplifier for your desired loop.
Here are the steps:
1.

With the modulator (also called plant or
control-to-output) transfer function
displayed as a gain-phase graph and
selected, click the Slide Bar icon or
right-click anywhere on the open graph
and click “Add Slide Bar”. Note that
data is “selected” by clicking anywhere
on either curve of the data set or
pressing the right- or left-arrow keys to
toggle through the various data sets
displayed. Also note that the Slide Bar
option is not available if more than one
data set is selected since the Slide Bar is keyed to a particular data set.

2.

When the Slide Bar is added to the
modulator transfer function data set,
click and hold it with the left mouse
button then move it to the desired loop
bandwidth. In choosing loop
bandwidth, remember that the response
time of a system to a transient is
approximately the reciprocal of the loop
bandwidth. Also remember that the
theoretical bandwidth limit of a
switching or sampled data system is
half the switching or sampled data rate.
As a practical matter, even though it is theoretically possible to cross the feedback
loop over at half the switching or sampling frequency, a more achievable number
will be in the range of 10-20% of the switching or sampling frequency.

3.

After choosing the desired loop bandwidth and
moving the Slide Bar to that frequency, note
that the text box associated with the slide bar
has a button labeled “Import to Analog
Synthesis”. Click that button. This will open
the “Error Amplifier Synthesis and Circuit
Analysis Menu” window and transfer the loop
crossover frequency to that window together
with the modulator gain and phase
measurements at that frequency.
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4.

In the Error Amplifier Synthesis and Circuit Analysis Menu window there are a
number of choices to make:

a)

Phase margin – Choose a value between 45 and 72 degrees. We recommend 60
degrees as a good starting point.

b)

Maximum circuit complexity – Type 1 is a simple integrator, type 2 has a single
zero-pole pair, and type 3 has two zero-pole pair. If the modulator transfer function
is flat at the chosen crossover frequency, choose type 1. If the modulator transfer

Type 1

Type 2

Type 3

function is falling at a -20 dB/decade slope at the chosen crossover frequency,
choose type 2. If the modulator transfer function is falling at a -40 dB/decade slope
at the chosen crossover frequency, choose type 3. An error message box on the
next (Component Values) tab will tell you if you chose an unachievable
combination.
c)

“Circuit is Inverting” check box – check this box if the modulator inverts (output is
180 degrees out of phase with the input) at low frequency. Leave it unchecked if
the modulator output is in phase with the input at low frequency. If the gain is flat
at low frequency (it should be), the circuit will be either inverting or non-inverting. It
will not have some in-between phase value if the test was performed correctly.

Inverting amp for non-inverting modulator
d)
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Non-Inverting amp for inverting modulator

Amplifier Topology – Regular is a conventional low output impedance amplifier
where the feedback compensation components are connected from error amplifier
output to inverting input. Transconductance is a high output impedance amplifier
where the feedback compensation components are connected from error amplifier
output to signal ground.
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Regular

Transconductance

e)

Input Resistor (R1) – this is the value of the resistor, which connects from the
modulator output to the error amplifier input. All feedback compensation
components scale from this resistor. If you want some other component in the
compensation network to have a particular value instead, choose a round number
like 1k for R1 and note the value of the component you want controlled. Then
change the value of R1 to make the other component come out the value you want.
All resistor values will be directly proportional to R1. All capacitor values will be
inversely proportional to R1.

f)

Input Voltage – this is the output voltage of the modulator or plant (which becomes
the input voltage of the compensation amplifier).

g)

Reference Voltage – this is the value of the reference voltage used to control the
output of the modulator. It could be a temperature-compensated zener diode, the
reference pin of a control integrated circuit, or an external reference or control
voltage.

h)

Common Mode Voltage – this is the voltage at the inputs of the compensation
amplifier. Both the inverting and non-inverting inputs of the amplifier will be at the
same voltage if the circuit is operating properly. The synthesis program will
determine the proper value of the resistive divider string from Reference Voltage to
the amplifier inputs so that the DC resistance driving each amplifier input is the
same. This is necessary for best amplifier performance.

i)

The only other entry is the error amplifier internal characteristics. Gain and
bandwidth come from the data sheet. If you do not know the amplifier output
impedance, use 1k. For transconductance amplifiers the gain, bandwidth, and
transconductance are specified on the data sheet.

5.

After you have entered in all the design values and choices, if you want to save the
values for later use click the “Save Design File” button and you will be prompted for
a file name and location. If not, go ahead and click the “Compute Component
Values” button. This will send you to the next (Component Values) tab with the
error amplifier compensation component values calculated already.
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6.

At the Component Values tab,
first check the “Error messages”
text box to see if anything
needs fixing. If not, choose the
preferred tolerances for
components in your company,
then click the “Round off
Component Values” button to
round off the values to the
nearest standard value for the
specified tolerance. We do not
use the tolerance in
calculations, so you can enter a
larger tolerance if you want
more standard values even though you plan to use a closer tolerance part in the
final design. For example, you may prefer to have the system choose a 1k resistor
instead of 910 ohms, so you can choose 10% or 20% tolerance instead of 5%
which might give you a value like 910 ohms. The information boxes in the lower
right quadrant of the window tell you where the poles and zeros of the amplifier
transfer function will be. You can also change any particular component value if a
similar value is more readily available and the new pole-zero locations will be
calculated and displayed so you can judge the impact of the change on overall loop
performance. Once the component values satisfy your criteria, click on the “Make
CKT model from component values” button.

7.

This will send you to the
“Circuit (CKT) Model” tab
and display a SPICE-like
net list of the model of the
compensation amplifier.
See the schematics and
models below for
reference. This net list can
be edited. Components
can be added or removed
or their types, values or
connections changed. The
one thing that cannot be
done is that a node cannot
be removed (skipped in the
node number sequence). Node numbers must be sequential starting with zero
(ground). If you change a circuit enough to remove a node, simply connect a
resistor from the node to ground. It will not have any effect on the circuit and the
analysis will still run properly. When you are happy with the net list, click the “Go to
Circuit Analysis Tab” button and you will be sent to the next (Circuit Analysis) tab.
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The figures below represent the amplifier schematics and models. The node numbers
and component reference designators are correct. The schematics and models differ
slightly for transconductance amplifiers, non-inverting amplifiers, and amplifiers where
the input voltage and reference voltage have different polarities.
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Type 1 Amplifier Schematic

Type 1 Amplifier SPICE Model

Type 2 Amplifier Schematic

Type 2 Amplifier SPICE Model

Type 3 Amplifier Schematic

Type 3 Amplifier SPICE Model
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8. The Circuit Analysis tab is where you set up the parameters of the AC analysis of
the net list. Choose the maximum and minimum frequency for the analysis sweep,
the node numbers you want
to save data for (you can
save all of them if you want
to), whether you want a log or
linear sweep and what the
resolution of the sweep is,
and finally whether or not you
want to activate the feature
we formerly called “Max Delta
Gain/Max Delta Phase”. This
feature measures the change
in gain and phase from one
analysis point to the next, and
if the gain or phase change
on any node is greater than
the amount specified, will cut the frequency step size in half and try again. This can
happen a maximum of 5 times (steps/decade x 32) up to a maximum resolution of
2000 steps/decade.
9. When the parameters of the
analysis are set to your
requirements, click the button
labeled “Compute AC analysis
from CKT”. This will take you
to the final tab, “Frequency
(AC) Data”. A brief description
of the origin of the data will be
at the top of the text display in
lines starting with * (asterisk).
Following the comment lines,
the data will be displayed in
Venable Standard Format
which is 5 columns:
Frequency, Node number,
Voltage (volts), Voltage (dB), and Phase (degrees). There will be a row for each
node selected at each frequency.
10. From the “Frequency (AC) Data” tab, click the “Import into Graph” button. If you
have followed the steps up to here, a gain-phase graph of the modulator transfer
function is already displayed and you will only see the second setup window asking
you to confirm the output node, input node, and scale factor. Click OK to accept the
default values of 2, 1, and 1.
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11. After clicking OK, the
setup menu will clear
and you will see the
graph with the
amplifier transfer
function gain and
phase superimposed
on the original
modulator transfer
function. At the
desired loop
crossover frequency,
the amplifier gain
should be as far
above (or below) the
0 dB gain axis as the
modulator gain is
below (or above).
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Generating Digital Coefficients from the Modulator Transfer Function
Once you have measured (or modeled) the modulator transfer function, you can have
the Venable System software generate the coefficients for the target processor to define
the compensation for your desired loop. Here are the steps:
1. With the modulator (also called
plant or control-to-output) transfer
function displayed as a gainphase graph and selected, click
the Slide Bar icon or right-click
anywhere on the open graph and
click “Add Slide Bar”. Note that
data is “selected” by clicking
anywhere on either curve of the
data set or pressing the right- or
left-arrow keys to toggle through
the various data sets displayed.
Also note that the Slide Bar option
is not available if more than one
data set is selected since the Slide Bar is keyed to a particular data set.
2. When the Slide Bar is added to the modulator transfer function data set, click and
hold it with the left mouse button then move it to the desired loop bandwidth. In
choosing loop bandwidth, remember that the response time of a system to a
transient is approximately the reciprocal of the loop bandwidth. Also remember that
the bandwidth limit of a switching data system is half the switching rate. As a
practical matter, even though it is theoretically possible to cross the feedback loop
over at half the switching or sampling frequency, a more achievable number will be
in the range of 10-20% of the switching frequency.
3. After choosing the desired loop
bandwidth and moving the Slide
Bar to that frequency, note that
the text box associated with the
slide bar has a button labeled
“Import to Digital Synthesis”. Click
that button. This will open the
“Digital Compensator Synthesis
and Analysis Menu” window and
transfer the loop crossover
frequency to that window together
with the modulator gain and phase
measurements at that frequency.
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4. In the Digital Compensator Synthesis and Analysis Menu window there are a
number of choices to make:
a) Phase margin – We recommend 60 degrees as a good starting point.
b) “Compensator is Inverting” check box – check this box if the modulator inverts
(output is 180 degrees out of phase with the input) at low frequency. Leave it
unchecked if the modulator output is in phase with the input at low frequency. If the
gain is flat at low frequency (it should be), the circuit will be either inverting or noninverting. It will not have some in-between phase value if the test was performed
correctly.
c) Sampling Period – The sampling time of the PWM generator in the target processor
is set in this box. It is the inverse of the processors PWM sampling frequency. This
will also be the bandwidth constraint of the feedback loop circuit.
d) Input Voltage – This is the output voltage of the modulator or plant (which becomes
the input voltage to the feedback divider).
e) Feedback Voltage – This is the voltage at the input of the ADC in the compensation
processor.
f) Target Selection – This list will be populated with all supported processors that are
licensed by Venable. The selection choice will control the algorithms that generate
the coefficients in the Compensator Coefficients section of the menu.
g) “Scale Coefficients” check box – This check box will adjust the coefficients into the
actual values to be coded into the target processors software. If PID is the selected
stage 1 setting, then the PID coefficients will be rescaled instead of the primary
coefficients. If left unchecked, raw algorithm coefficients are generated.
h) Stage 1 Compensator Type – Type 1 is a simple integrator, type 2 has a single zeropole pair, and type 3 has two zero-pole pair. A PID is a compensator that has two
zeros and no poles. It will generally be couple with a second stage pole filter. If the
modulator transfer function is flat at the chosen crossover frequency, choose type 1.

Type 1
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Type 3

If the modulator transfer function is falling at a -20
dB/decade slope at the chosen crossover frequency,
choose type 2. If the modulator transfer function is
falling at a -40 dB/decade slope at the chosen
crossover frequency, choose type 3. The error
message box will tell you if you chose an
unachievable combination.
PID
i) Stage 2 Type – This allows selection of a second stage filter for those processors
that utilize them. Generally, this will consist of either a 1st order Low Pass Filter or
2nd order Low Pass Filter. The cutoff frequencies for these settings can be input for
the poles. A “Custom” mode also is included with parameters set in the Custom
parameters section. Refer to the Application Notes for your specific processor if you
need to use the custom mode.
5. After you have entered in all the
design values and choices, click
the “Compensator Analysis”
button. This will send you to the
next (Compensator Analysis) tab.
6. The Compensator Analysis tab is
where you set up the parameters
of the AC analysis of the
computed coefficients. Choose
the maximum and minimum
frequency for the analysis sweep,
whether you want a log or linear
sweep and what the resolution of
the sweep is, and finally whether or not you want to activate the feature we formerly
called “Max Delta Gain/Max Delta Phase”. This feature measures the change in
gain and phase from one analysis point to the next, and if the gain or phase change
on any node is greater than the amount specified, will cut the frequency step size in
half and try again. This can happen a maximum of 5 times (steps/decade x 32) up
to a maximum resolution of 2000 steps/decade.
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7. When the parameters of the analysis are set to your requirements, click the button
labeled “Compute AC analysis”.
This will take you to the final tab,
“Frequency (AC) Data”. A brief
description of the origin of the
data will be at the top of the text
display in lines starting with *
(asterisk). Following the
comment lines, the data will be
displayed in Venable Standard
Format which is 5 columns:
Frequency, Node number,
Voltage (volts), Voltage (dB),
and Phase (degrees). There will
be a row for each node selected
at each frequency.
8. From the “Frequency (AC) Data” tab, click the “Import into Graph” button. If you
have followed the steps up to here, a gain-phase graph of the modulator transfer
function is already displayed and you will only see the second setup window asking
you to confirm the output node, input node, and scale factor. Click OK to accept the
default values of 2, 1, and 1.

9. After clicking OK, the
setup menu will clear
and you will see the
graph with the
compensator transfer
function gain and
phase superimposed
on the original
modulator transfer
function.
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Calculation of the Predicted Overall Feedback Loop Transfer Function
Before you install the various resistors and capacitors of the compensation network in
the circuit, you would probably like to know what the overall feedback loop transfer
function will look like. After all, you may want to do some tweaking before you solder
everything in. Predicting the loop gain is easy. Here are the steps:
1.

Display both the modulator transfer function and the amplifier transfer function on a
gain-phase graph. If you followed the steps in the previous sections, they are
already displayed. Note the data set number of each of the two data sets (the
modulator gain and phase curves are a data set and the amplifier gain and phase
curves are another data set).

2.

Click on the icon called “Do Math on Data”, the one with the four math
symbols on it. In the “Math Options for Gain-Phase Data” window, set
the left operand to the number corresponding to one data set and the
right operand to the number corresponding to the other data set. This
will usually be 1 and 2 if only two data sets are displayed. Select the “Multiply”
option, then click the button called “Create”.

3.

When you click the “Create” button, the math window will close and the loop
transfer function will appear on the graph as an additional data set. It will be
“selected” and you will be able to see the individual data points. The loop gain
should cross the 0 dB line at approximately the frequency you chose as the desired
loop frequency and the phase margin should be approximately the phase margin
you asked for. The differences between
actual and desired values are caused by
rounding off the component values and by the
limitations of the op-amp selected. If you
don’t round off the component values and you
do set the gain and bandwidth of the op-amp
at high values, the actual and desired values
will be identical. In real life, however, you
have to use available components and real
op-amps and the predicted results will be very
close to the actual measurements.

4.

If you want to document the results, select (click on) only the final gain and phase
plots and add slide bars by clicking on the slide bar icon (the one with the yellow
vertical line). Slide bars are keyed to data sets so the slide bar icon is available
only when one data set is selected. You can have as many slide bars as you want,
but two is usually a nice number. You can put one slide bar on gain crossover and
the other on phase crossover. That will give you numerical readouts of the loop
bandwidth, phase margin, zero phase bandwidth, and gain margin. As a final
touch, you can add a text box by clicking on the text box icon (with the “A” on it). A
brief description of the source of the data and the time and date it was created are
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entered automatically in the box. You can edit or add to this information to
document the model and serial number, test conditions, values of the various
components, or anything else you think will be of value when you or someone else
looks at the plot.
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Loading and Saving Settings
The Venable System software allows the user to save and recall user and/or testspecific Analyzer Control menu settings, the Error Amplifier Synthesis and Circuit
Analysis menu entries, and user defined default Data Set Properties. Normally, when
the application is closed, the internally saved settings are written to an ASCII text file
called VENPREF.TXT located in Venable System directory. The program will create
this file if one does not exist in the Venable System directory.
The Analyzer Control menu parameters saved internally in the application after the
menu is closed are: Sweep Generator parameters, Input Channel parameters, Servo
Control, Channel Ratio and the Maximum Change Between Data Points settings. When
saved, the user can recall test-specific Analyzer Control menu settings at a future time.
The Error Amplifier Synthesis and Circuit Analysis menu entries saved internally in the
application after the menu is closed are: Loop Design parameters, Component Values,
Circuit Model, Circuit Analysis settings, and the Frequency Data. By saving these
values, the user can save an entire error amplifier design including simulation data.
The default Data Set Properties saved are: the channel ratio, scale factor, gain or
impedance data set colors, and phase colors. Voltage colors for the voltage display are
saved separately from the data colors of the other plots. User defined Data Set
Properties are saved as defaults by clicking on the Save as Default button in the Data
Set Properties dialog box. Any plots opened after a set of defaults has been saved will
also have those defaults. Saving these properties reduces the workload, especially,
when making a large number of measurements.
To save your settings to a file you must:
1. Close the Analyzer Control Menu and/or the Error Amplifier Synthesis and Circuit
Analysis menu to save your settings internally. Save as Default any changes
made to the data set properties.
2. Left-click on the Save Settings menu item on the File program menu and save
them as a text file to any directory you wish.
To load your saved settings from a file you must:
1. Close the Error Amplifier Synthesis and Circuit Analysis menu or any open data
plots before loading your saved settings to avoid any confusion. The settings will
not load into these windows if they are open.
2. Left-click on the Load Settings menu item on the File program and select the
settings file that you wish to load.
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Display Documentation Features
Several documentation features can be added to the graph displays. Any number of
Graph Description text boxes, which are associated with each graph, can be added to
the display. This text box is separate from the Data Description text box that records
and time stamps the test set up and is associated with each data set. The Slide Bar
and its associated window are useful for tracking and displaying data values at a
specific frequency. The display can also include a graph title. It can be hidden or
unhidden as needed. Finally, a graph legend text box that associates a y-axis label with
data set colors may be displayed. It can also be hidden or unhidden as needed. All
these documentation features are located under the View program menu.

The screen shot above shows the display documentation features for Venable System
software plots. Clockwise from the top left are the Graph Legend, Graph Title text box,
the Graph Description text box, Data Description text box and the Slide Bar. Also note
that the data set number, which is located on the left-hand side of the data set, can be
hidden.
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Show Data Description
Displays a text description of the selected data in a pop-up text window. This command
is only active when a single data set is selected. This window is useful for documenting
the conditions under which the measurement was made such as temperature, load
condition, etc. The Venable software always makes two default entries in Data
Description text display window: a date-time stamp and the source of the data i.e. the
particular type of analyzer or the Synthesis/Circuit Analysis Menu. When you copy a
data set, this text description is copied as well. The Data Description is the text header
located at the top of the data table in the Text Display window.
Add Graph Description
Adds a Graph Description text box to the graph display. This text box is useful for
describing the graph display. The user can edit or add text by double clicking the
mouse on the text box. By right-clicking the mouse on the text box, the user can delete
the Graph Description text box, select text justification, or select a new font, font style,
size, effects, or color. This text box can be moved or resized by dragging it with the
mouse. There is no set limit to the number of Graph Description text boxes that can be
opened.
Show Data Numbers
Shows or hides the display of the number and the identifying text attached to each data
set. The data set number and the plot name are located at the top of each data table
displayed in the Text Description window.
Show Graph Title
Toggles the visibility on and off of the title text box at the top of the graph display. The
user can edit or add text by double clicking on the Graph Title text box. By right-clicking
the mouse on the Graph Title text box, the user can toggle visibility, select text
justification, or select a new font, font style, size, effects, or color. This box cannot be
moved or resized.
Show Graph Legend
Toggles the visibility on and off of a text box that identifies the number and colors
assigned to each data set when that data set is selected. If no data set is selected the
number and colors of the lowest numbered visible data set are displayed. This box may
be moved but can’t be resized.
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Slide Bar Window

Nyquist Slide Bar Window

Add Slide Bar
The slide bar is useful for tracking and displaying data values at a specific frequency,
represented by a vertical line, or in the case of the Nyquist graph a specific phase,
represented by a radial line, and a description box. The Add Slide Bar command can
only be run when a single data set is selected. More than one slide bar may be opened
at one time, either from the same or different data sets. Add Slide Bar is not available in
a text display window.
The bar can be dragged using the mouse pointer, and the box will contain the data at
the selected frequency or frequency and phase in the case of the Nyquist graph. The
frequency or phase can also be typed in, and the line will move to that frequency or
phase respectively. Since the slide bar may cross the data set more than once on a
Nyquist plot, a colored cursor was added to the plot so the user may determine which
data is being read by the slide bar and displayed in the description box. The crossing
point on the Nyquist plot can be changed with the Values at Gain Crossing scroll box.
You can use the Left or Right-Arrow key shortcut to move the slide bar left or right
between data points taken by the analyzer. The Shift+Left or Right-Arrow key shortcut
finds the 0 degree, +/-90 degree, or the +/-180 degree phase points (inductance,
resistance, capacitance, or gain Margin) if they exist. The Ctrl+Left or Right-Arrow key
shortcut finds the 0 dB crossing point (phase margin) if it exists. The user can also click
on the Get Unity Crossing button to find the 0 dB crossing point.
The Import Values To Synthesis button in the description box on the Gain–Phase graph
display imports the slide bar values directly into the Error Amplifier Synthesis and Circuit
Analysis Menu.
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Installing the Venable Matlab files
Move the Venload.m, Vendlmread.m and Vensave.m files to a directory in the Matlab
path or create a directory and place it in the Matlab path. These files are installed in
“C:\Program Files\Venable Instruments\Venable Software\Matlab m-files” for 32 bit
Windows and they are installed in “C:\Program Files (x86)\Venable Instruments\Venable
Software\Matlab m-files” for 64 bit Windows. In Windows 7, normal users cannot enter
into Program Files. You can open a file explorer window to this directory from the
Venable Software’s menu item “Help>>Matlab m-files”.
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Add the directory to the Matlab path. You can do this by opening Matlab. For
Matlab 5 and 6, select Set Path from the File menu. The Path Browser will
open and you can add any directory to the Matlab path.

2.

Make the “C:\Program Files\Venable Instruments\Venable Software\Matlab
m-files” directory the current directory. For Matlab 5,use the CD command to
change the current directory i.e. cd 'C:\Program Files\Venable
Instruments\Venable Software\\Matlab m-files '. For Matlab 6, select Current
Directory from the View menu. The Current Directory Browser will open and
you can make any directory the current directory.
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Exporting Data from the Venable Software
The Venable software uses tab delimited ASCII text when exporting or importing data.
The Venable software saves data in this form when you select, cut or copy, and paste
data to the clipboard or save it to a text file. Data in this form can be easily exported to
or imported from Excel, Matlab, or Mathcad applications.
Venable Data Formats
Venable data can be exported or imported in two different formats. The Voltage or DOS
format is the 5-column raw data acquired from each analyzer channel. Data from the
DOS versions of the Venable software can be imported and saved using the Voltage
format. This format also allows users to examine the raw measurements and do their
own calculations on the data. The Magnitude-Phase format is the 3-column text
representation of a particular data set plotted on a Venable software plot. The majority
of users will find this the most useful format for exporting or importing data. The plotted
data set consists of a channel ratio multiplied by a scale factor. The channel ratio and
scale factor settings for each plotted data set can be changed and are located in the
Data Set Properties for each plot.
1. To view the two different data formats, open up a Venable plot containing plotted
data sets.
2. You can observe the data in the two different text formats by going to the
Window program menu in the Venable application and selecting Add Text
Display.
3. Go to the Edit pull-down menu and if the Voltage Format for Cut/Copy is
checked, the data will be displayed in Voltage format. The scale factor will be
noted but not multiplied by the data. See the example below.
Gain4.ven: Data 12:
*Data from Synthesis / Circuit Analysis Menu
*01:26PM Wednesday, December 04, 2002
*Gain/Phase: Output Node=2, Input Node=1, Scale Factor=10
*Frequency (Hz) Channel or Node Voltage (Volts) Voltage (dB) Phase (Deg)
1
1
1
0
0
1
2
3.63637
11.2134
-0.1391
1.25893
1
1
0
0
1.25893
2
3.63637
11.2134
-0.1751
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If you uncheck the Voltage Format for Cut/Copy menu item by clicking on it, the data will
be displayed in the Magnitude-Phase format. The scale factor will be multiplied by the
channel ratio. See the example below:
Gain4.ven: Data 12:
*Data from Synthesis / Circuit Analysis Menu
*01:26PM Wednesday, December 04, 2002
*Frequency (Hz)
Gain (dB)
1
31.2134
1.25893
31.2134

Phase (Deg)
-0.1391
-0.1751

Exporting Venable data using the Clipboard
The Venable plot data including the data header is exported to the clipboard as tab
delimited ASCII text. Here are the steps you should follow to export data from the
Venable software to the clipboard and to paste the data to another application:
1. Open up the Venable plot containing the data to be exported with the Venable
software.
2. Go to the Edit program menu and make sure the Voltage Format for Cut/Copy is
unchecked to export data in the Magnitude-Phase format.
3. Select the data set to be exported from the plot by left clicking on the data (Black
squares appear on the data set when it's selected and the data set number turns
yellow). With a plot selected, different data sets can be scrolled through if there
is more than one on a plot by hitting the up and down arrow keys on the
keyboard.
4. When the plot to be exported is selected, go to the Edit program menu again and
select Copy or use the Ctrl-C shortcut keys.
5. Either open the Circuit Analysis Menu, which is located in the Actions program
menu. Left-click on the Frequency (AC) data tab. Right click for the Edit pulldown menu and select Paste or hit the Ctrl-V keys to paste the data into the text
window. The file is now in tab delimited ASCII which you can save by clicking on
the Save AC File button.
6. Or open up a text editor, like Notepad or WordPad, and directly paste the data
into it. Make sure to save the data as a text file in WordPad.
7. Or open up a spreadsheet application like MS Excel and directly paste the data
into the workbook.
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Exporting Venable data using Export to Matlab/Mathcad
The Venable plot data is exported to a text file (.dat) as tab delimited ASCII text. This
function removes the data header because Matlab arrays and Mathcad input tables do
not handle mixed data types. Below are the steps that should be followed to export
data from the Venable software to the Matlab or Mathcad.
1. Open up the Venable plot containing the data to be exported with the Venable
software.
2. Go to the Edit program menu and make sure the Voltage Format for Cut/Copy is
unchecked to export data in the Magnitude-Phase format.
3. Select the data set to be exported from the plot by left clicking on the data (Black
squares appear on the data set when it's selected and the data set number turns
yellow). With a plot selected, different data sets can be scrolled through, if there
is more than one on a plot, by hitting the up and down arrow keys on the
keyboard.
4. Go to the File pull-down menu and click on the Export To Matlab/Mathcad menu
item. The file Save As pop-up window will open. The data is saved as a tab
delimited data (.dat) file with the Venable text header removed. See the example
below:
1
1.25893

31.2134
31.2134

-0.1391
-0.1751

Exporting a Venable Plot as a Graphics File
The Venable can save plots in JPEG graphics format, which can be read by any web
browser or easily pasted into Word. The functions for exporting graphics files are all
located under the File program menu.
Copy Graph
Copy graph is located under the File program menu. It copies the active graph
including titles, legends, slide bars and data descriptions to the clipboard in JPEG (.jpg)
format using the default compression. The plot can then be inserted into other
programs such as Word or PowerPoint for reports or presentation. A similar command
is to use Alt-Print Screen to capture the active graph on to the clipboard as a Windows
bitmap. In this case, you will have to use a graphics file editor to remove the window
portion from around the graph.
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Save To JPG
Save To JPG is located under the File program menu. It saves the active graph
including titles, legends, slide bars and data descriptions to a file in JPEG (.jpg) format.
A Jpeg Quality pop-up window, as shown on the next page, prompts the user for the
amount of compression to be used in saving the file. The compression shown in the
figure is the default. The more compression that is used when saving a file in JPEG
(.jpg) format, the smaller the size of the saved file, but also the poorer the resolution.

Jpeg Quality Window
Mail To
Mail To is located under the File program menu. It opens the users default email
program and attaches the active graph to a New Message. The Mail As pop-up window
opens up as shown below and gives the user an option of attaching a file in the JPEG or
Venable file format. Venable files are typically very small and are the most convenient
format for emailing. However, the recipient needs The Venable System software or the
Venable Reader to open this file type. If the JPEG format is selected, the user is given
an option for the amount of compression to be used in the attached file. Again, the
more compression that is used when saving a file in JPEG (.jpg) format, the smaller the
size of the saved file, but also the poorer the resolution.

The Mail As Pop-up Window
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Importing Venable data into Excel
To import data into Excel you can directly paste any data copied on to the Clipboard
from the Venable software directly into an Excel worksheet or you can open up any tab
delimited text files that have been saved. When opening a delimited text file with Excel,
the Text Import Wizard panel will open up. Choose delimited option and click on Finish
to import the file.
Importing Venable data into Mathcad
Data can be imported into Mathcad using three methods:
1.

The user can go to the Mathcad Insert program menu, select the Component
menu item, and then select Input Table. Type a variable name into the
placeholder for the input table. Right click on the input table and select Import
from the pop up menu. Browse for a data file saved by the Export to
Matlab/Mathcad method or a file with the Venable text header removed and
click Open. This method reads the data from the data file only once when the
data is imported instead of each time the work sheet is calculated.

2.

Data can also be imported by going to the Insert pull-down menu, selecting
the Component menu item and then selecting File Read or Write. The File
Read or Write Wizard should appear. Choose Read from a file, Text Files for
the File Format, and browse for the data file and click on Finish. Type a
variable name into the placeholder in the Read/Write component icon to
which the data from the file will be assigned. Type the variable name and
‘=’to display the data in an input table. Mathcad re-reads the data from the
file each time the work sheet is calculated.

3.

Data can also be imported using the READPRN function. The proper syntax
is to put the file path inside quotes inside the function parentheses as shown
below:
M:= READPRN(“C:\Program Files\Venable Inc\Venable System\mod.dat”)
Type the variable name and ‘=’ to display the data in an input table.
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Importing Venable data into Matlab
Matlab uses Matlab m-files Venload.m and Vendlmread.m created by Venable to import
data into a Matlab array. These files are located in a sub-folder of the program
installation directory. Use the menu item, Help -> “Matlab m-files”, to open up a
Windows Explorer window to the folder containing these files. The Venload.m and
Vendlmread.m files must be placed in the Matlab path or current directory. See the
topic on Installing the Venable Matlab Files. Once these files are placed the in the
Matlab path or current directory, the Venload function can be called from the Matlab
command window or any user created m-file. A description of the functions and Matlab
syntax is provided below.
Venload.m: Sets “C:\Program Files\Venable Instruments\Venable Software” directory
as the current directory, retrieves the tab-delimited text file name and calls the
Vendlmread.m function. A tab-delimited text file with the file extension *.dat is created
using the Export To Matlab/Mathcad function under the File menu in the Venable
System software.
Matlab Syntax: venload, loads file into the most recent answer array, ans.
Matlab Syntax: a = venload, loads file into array, a.

Vendlmread.m: Parses and loads Venable frequency response data from a tabdelimited text file into a Matlab array.
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Importing Data into the Venable Software
The Venable software uses tab delimited ASCII text when exporting or importing data.
Data has to be in this form to be imported into the Venable software.
Venable Data Formats
Data can be imported using two different text formats. The Voltage or DOS format
shows the 5-column raw data acquired from each analyzer channel. Data from the
DOS versions of the Venable software can be imported and saved using the Voltage
format as shown below.
Gain4.ven: Data 12:
*Data from Synthesis / Circuit Analysis Menu
*01:26PM Wednesday, December 04, 2002
*Gain/Phase: Output Node=2, Input Node=1, Scale Factor=10
*Frequency (Hz) Channel or Node Voltage (Volts) Voltage (dB) Phase (Deg)
1
1
1
0
0
1
2
3.63637
11.2134
-0.1391
1.25893
1
1
0
0
1.25893
2
3.63637
11.2134
-0.1751
The Magnitude-Phase format is the 3-column text representation of a data set as plotted
on a Venable software plot. The plotted data set consists of a channel ratio multiplied
by a scale factor. When importing 3-column data the default scale factor will be unity
and the default channel ratio set to 2/1. The channel ratio and scale factor settings for
each plotted data set can be changed and are located in the Data Set Properties for
each plot. An example of the 3-column format is shown below.
Gain4.ven: Data 12:
*Data from Synthesis / Circuit Analysis Menu
*01:26PM Wednesday, December 04, 2002
*Frequency (Hz)
Gain (dB)
1
31.2134
1.25893
31.2134

Phase (Deg)
-0.1391
-0.1751

Data is often saved as a tab delimited data file without the Venable text header. Data
can be imported in this form also. See the example below:
1
1.25893
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-0.1391
-0.1751

Exporting tab-delimited text data from Excel
To export data from Excel you can select and copy data from cells on to the Clipboard
and paste directly into a Venable software plot or the Frequency (AC) Data window in
the Circuit Analysis Menu. You can also save the data into a tab-delimited text file with
Excel. The data must be in the 3-column Magnitude-Phase format or 5-column Voltage
format if it is to be successfully imported into the Venable software.
Exporting tab-delimited text data from Mathcad
Data can be exported from Mathcad as a tab-delimited text file using three methods.
The exported Mathcad data must be in the 3-column Magnitude-Phase format or 5column Voltage format if it is to be successfully imported into the Venable software.
1. Type the data array variable name and ‘=’ to display the data in an output table.
Right click on the output table and select Export from the pop-up menu. Save
the data to a tab-delimited text file with a *.dat file extension. This method reads
the data from the data file only once when the data is exported instead of each
time the work sheet is calculated.
2. Data can also be exported by going to the Insert pull-down menu, selecting the
Component menu item and then selecting File Read or Write. The File Read or
Write Wizard should appear. Choose Write to a file, Tab-Delimited Text for the
File Format, and browse for a data file name and directory to where the data is to
be written and click on Finish. Type a variable name containing the data to be
written to the file into the placeholder in the Read/Write component icon and hit
Enter. The data will be written to the specified file. Mathcad re-writes the data to
the file each time the work sheet is calculated.
3. Select all the data by clicking in the upper left corner of an input or output table.
Use the Ctrl-C copy shortcut keys to copy the data to the clipboard. The data
can be pasted directly into a Venable software plot, Excel or any text editor and
saved.
Data can’t be exported using the WRITEPRN function. This function uses spacedelimiting and space-delimited text files can’t be read by the Venable software:
Exporting tab-delimited text data from Matlab
Matlab uses a Matlab m-file Vensave.m created by Venable to export data into a tabdelimited text file. This file is located in the “C:\Program Files\Venable
Instruments\Venable Software” directory. The Vensave.m-file must be placed in the
Matlab path or current directory. See the topic on Installing the Venable Matlab Files.
Once this file is placed the in the Matlab path or current directory, the Vensave function
can be called from the Matlab command window or any user created m-file. A
description of the function and Matlab syntax is provided on the next page.
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Vensave.m Creates a tab-delimited text file from a Matlab array in a suitable format
for importing into the Venable System software. The data must be in the 3-column
Magnitude-Phase format or 5-column Voltage format if it is to be successfully saved to a
file. The tab-delimited text file (*.dat) can be imported into the Venable System software
using the Import From Matlab function under the File menu.
Syntax: vensave(venarray), saves the array to a tab delimited text file.
Syntax: a = vensave(venarray), saves the array to a tab delimited text file.
a = 1 if the file is successfully saved.
a = 0 if the file is not saved.
Importing data into the Venable software using the Clipboard
The Venable plot data including the data header can be exported to the clipboard as tab
delimited ASCII text from Excel and Mathcad. There are two methods you can follow to
import data into the Venable software from the clipboard.
1. Paste the tab delimited ASCII text data directly to plot from the clipboard. Data
can be directly copied to the clipboard from Excel workbook or from Mathcad
Input or Output tables.
2. Open the Circuit Analysis Menu, which is located in the Actions program menu.
Left-click on the Frequency (AC) data tab. Right click for the Edit pull-down menu
and select Paste or hit the Ctrl-V keys to paste the data into the text window.
Left-click on the Import into Graph button to import data into the plot.
Importing data from Matlab or Mathcad into the Venable software
The Import From Matlab/Mathcad function imports data files with a file extension of *.dat
saved by either Matlab or Mathcad into the Venable software plot. It will import data
files saved with or without a data header. To use this function do the following:
1. Go to the File program menu and click on the Import From Matlab/Mathcad menu
item. The File Open pop-up window will open up.
2. Browse for the tab-delimited text file containing the data to be imported and leftclick on the Open button to import data into the plot.
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Using the Venable Circuit Analysis Menu to Import Data
The Frequency (AC) data window in the Circuit Analysis Menu imports data files with a
file extension of *.ac saved by Venable DOS software. It will also import tab delimited
ASCII text data files (*.dat and*.txt) saved with or without a data header. To use this
function do the following:
1. Open the Circuit Analysis Menu, which is located in the Actions program menu.
Left-click on the Frequency (AC) data tab.
2. Left-click on the Open AC File button and the File Open pop-up window will open
up. Browse for the tab-delimited text file containing the data to be imported and
left-click on the Open button to import data into the text window. Left-click on the
Import into Graph button to import data into the plot.
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Description and Uses of Accessories
Part number
200-001

Description
Low frequency
injection transformer

200-002

Medium frequency
injection transformer

200-003

High frequency
injection transformer

200-004

Electronic injection
transformer, DC-2.2
MHz
Power supply for
200-004
Clip-on injection
transformer

200-005
200-006

200-009

Balun to reject
common mode
noise

200-000

Very low frequency
injection
transformer.
RLC Meter

350-RLC

2249-C-60
5187-C-60
3782-36-X
IOZ-10
IOZ-50
IOZ-100
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BNC-BNC Cables
BNC-Minigrabber
Cables
Banana-Minigrabber
Cables
Input/Output
Impedance
Measurement Test
Set.
Also used for
conducted
susceptibility testing.

Function
Couples and isolates AC source from
circuit under test. Useful frequency range 1
Hz-10 kHz.
Couples and isolates AC source from
circuit under test. Useful frequency range
10 Hz-100 kHz.
Couples and isolates AC source from
circuit under test. Useful frequency range
100 Hz-1MHz.
Couples and isolates AC source from
circuit under test. Voltage on circuit must
be ±16 volts or less.
Part of 200-004.
Clips onto wire to inject signal without
breaking circuit. Useful frequency range 1
kHz-15 MHz.
Connects in series with injection
transformer to block high frequency
common mode noise between circuit under
test and measuring instrument.
Used to measure the voltage loop in power
factor correction circuits. Useful frequency
range 0.1 Hz to 1 kHz.
Test fixture and software to automatically
measure resistance, inductance, and
capacitance of up to three components.
Connect FRA to injection transformer.
Connect FRA directly to circuit under test.
Connect injection transformer to circuit
under test.
High power injection transformer for
injecting up to 300 watts of AC power into
lines carrying DC current of up to 50 or 100
amps depending on model selected.
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Calibration of Oscilloscope Probes for Flat Frequency Response
To read voltages higher than the hardware limits listed below or to minimize probe
loading on a sensitive part of a circuit, you can use ordinary attenuating oscilloscope
probes on the FRA inputs.
Model
3215/3225/3235
350a/350b/250/220
HP3577
3120
43xx/63xx/74xx/88xx/350c

Voltage Limit
10 Vpk
300/300/15.0 Vpk
25 Vpk
500 Vpk
500 Vpk

These probes have a series resistor (9 mega ohms in the case of a 10:1 probe)
paralleled by a variable capacitor. The inputs of the FRA are 1 mega ohm, just like an
oscilloscope, so the probes work on the FRA just as they do on an oscilloscope. Also,
as on an oscilloscope, the probes have to be
“calibrated”. As with a scope, the term “calibration”
means adjusting the variable capacitor that is in
parallel with the series resistor so that the capacitive
divider ratio is the same as the resistive divider ratio.
The inputs of the FRA have a capacitance of about
50 pF, slightly more than most oscilloscopes, so the
calibration for an oscilloscope will be slightly different than for an FRA. Here are the
steps for calibrating a probe:
The objective is to treat the probe as a circuit you are trying to measure the frequency
response of, then to adjust the variable capacitor so the attenuation at high frequency
(determined by the ratio of the capacitors) matches the attenuation at low frequency
(determined by the ratio of the resistors). The transition between low frequency and
high frequency is typically in the range of 1-3 kHz. To do this, connect one of the BNCMinigrabber cables provided to the FRA
oscillator output. Connect the probe to
the input channel you plan to use it on,
then connect another BNC-Minigrabber
cable to another input channel. If you
plan to use more than one probe,
calibrate them one at a time on the input
channel they are to be used on.
Connect all the grounds together and
connect both the red Minigrabbers to the
probe tip. For example purposes, we will
assume that the probe is on channel 2 input
and the Minigrabbers are on the oscillator
output and channel 1 input.
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Open the Venable System software and open a new Gain and Phase plot. Click the
Analyzer Control icon to open the Analyzer Control menu. Set the sweep from 10 Hz to
100 kHz, log sweep at 10 steps /decade. The voltage is not critical.
You may want to set the HP3577 analyzer to a 100.2 mVrms sine wave, otherwise the
unattenuated input will overload. The attenuated input channel will read 10 mVrms in
the data box in the upper-right corner of the Analyzer Control window.
You may want to set the other analyzers (except 220) to a 1.414 volt sine wave
because the oscillator is specified in volts peak so the input channel will read 1 Vrms in
the data box in the upper-right corner of the Analyzer Control window. The AC Volts
Out for the Model 220 is already in Vrms.
When the sweep parameters are set, click the
“Take Data at Start Freq” button and let the
analyzer take two or three readings. Check
the data box to make sure everything is
working. For example, if you used the same
settings and channels as the example, the
Frequency will be 10 Hz, Channel 1 will be 1
Vrms, and Channel 2 will be 0.1 Vrms if you
are using a 10:1 probe. If everything is OK,
click the “Run Sweep” button.
Again, you may want to minimize or move the
Analyzer Control window so you can see the
data in real time. If the probe is not calibrated
correctly, there will be a small step in the
Uncalibrated probe
attenuation at the frequency where the divider
changes from a resistive divider to a capacitive
divider, usually in the range of 1-3 kHz. More noticeable than the gain step will be a
phase “bump” or “dip” at the same frequency. The phase will have a “bump” if the high
frequency gain is higher and a “dip” if the high frequency gain is lower.
When the sweep is complete, note the frequency of the peak or valley of the phase
curve. You can add a slide bar to make it easier to measure the frequency.
Open or maximize the Analyzer Control window and set the start frequency to the
frequency of the peak or valley of the bump or dip in phase. Click the “Take Data at
Start Freq” button and note the Phase reading in the data box in the right-center part of
the Analyzer Control window. It should be the same as the peak or valley phase
reading on the gain-phase graph.
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Turn the adjustment screw on the probe to set the phase as close to zero as possible.
Zeroing the phase at the corner frequency automatically flattens the gain curve. If you
want, you can do another sweep from 10 Hz to 100 kHz to check your handiwork.
Transfer function of calibrated probe.
The gain and phase deviations at 1 kHz
are minimized. Note the narrow gain
and phase ranges of the graph.
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Measurement of the Loops in a Multi-Loop Power Supply
By multi-loop, we mean there are several paths for the signal to take as it goes around
the circuit, essentially creating a number of different loops which have some parts in
common and other parts as separate parallel paths. This is common in power supplies
that use a TL431 and optocoupler to cross the isolation barrier, in power supplies that
use feedback from more than one output, and in magamp post-regulator circuits.
This is not to be confused with the term “multi-loop control” coined by Virginia
Polytechnic Institute (VPI) to describe current-mode control. There are a number of
viewpoints about the significance of the current loop, exemplified by the controversy
between VPI and the California Institute of Technology (Cal Tech) on this subject. The
view here at Venable Industries is that the current loop simply forms a
transconductance gain block in the overall loop and can be treated as one more gain
block in series with a number of other gain blocks in the overall loop.
+12VDC
Vin
+5VDC
Error
Amplifier

Ramp or
current

Ground
PWM

Power
FET

Comparator
+5 Ref

R1

Opto

"Comp Pin"

R2

R3

TL431
Opto

Noise
Filter

Signal Gnd

Power Gnd

“Untestable” power supply has no single path meeting impedance criteria.

The above figure shows an “untestable” power supply. Unfortunately, this topology is
not that unusual. There is no single path that meets the criteria of coming from a low
impedance and driving a high impedance. The path into the “Comp Pin” of the PWM
chip might qualify, but it is hard to be certain because the source impedance is high and
the input impedance of the “Comp Pin” is unspecified. In addition, this point is usually
very noise sensitive.
On the secondary side there are three paths that meet the impedance criteria, but all
three of these paths are in parallel. There are two paths that most people recognize:
the 5 V loop through R2 and the 12 V loop through R3. It is common to take part of the
feedback from the 5 volts and part from the 12 volts so that instead of having one output
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be perfectly regulated and the other vary 10% or so with line and load changes, both
outputs vary by about 5%. The path that is not widely recognized is the path through
R1. We call this the “fast loop” because it is the loop that dominates at high frequency.
This path originates because the gate (control pin) of the TL431 is a virtual ground, and
the capacitor connected from there to the cathode makes the cathode a virtual ground
also at high frequency. Any AC voltage on the 5 V output modulates the current in the
optocoupler diode directly through R1 by virtue of the fact that the branch ties between
the 5 V output and a virtual ground. This direct modulation of the current in the
optocoupler diode is much faster than the signals through R2 and R3, especially in the
presence of the capacitor from cathode to gate.
In this topology example, there is a second L-C filter after the power stage to further
reduce switching ripple at the output. This is also common, but the phase shift through
the second L-C filter makes it difficult if not impossible to cross the loop over at a high
bandwidth while sensing directly at the output of the power supply. Some designers
solve this problem by connecting the “fast loop” through R1 to the junction between the
power stage and the second L-C filter as shown in the example, avoiding the excess
phase shift in the “fast loop”. The “slow loop” through R2 and R3 provides good DC
regulation. The AC loop response does not compensate for the second-stage L-C filter,
but the fact that the loop bandwidth is much higher that would otherwise be possible
means that the overall performance may actually be improved over a slower loop with
the “fast” path tied to the output after the second-stage filter.
The problem with this topology is that there is no common point between the fast and
slow loops as there is in the example given earlier in the basic part of this manual. If
there was, at least the fast and slow 5 V loops could be combined into a single path. In
this case, all three of the loops are separate. We solve this problem by measuring the
loops separately and then combining them mathematically using the “Do Math on Data”
window. One of the options in this window is called “Double to Single Loop”. Parallel
loops can be combined mathematically by the formula:

LOOPGAIN =

GAIN1 + GAIN2 − 2 × GAIN1× GAIN2
1 − GAIN1× GAIN2

This is the formula implemented in the “Double to Single Loop” function of the “Do Math
on Data” window. When there are more than two loops, as in this case, the loops can
be combined in pairs and the result combined with the additional loops one at a time.
When the true loop gain is high, the product of GAIN1 x GAIN2 will be close to 1 and
the denominator of the equation will be small. The slow loop and fast loop will both
cross the 0 dB gain axis at approximately the same frequency. With this formula there
is the problem of a small difference between two similar numbers since at low frequency
the term GAIN1 x GAIN2 is very close to +1. At low frequency the denominator of the
equation is small since it is the difference between +1 and another number very close to
+1. This causes some inaccuracy in the gain measurement when the gain is very high,
but near loop crossover the gain is small and the small difference of large numbers
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problem becomes insignificant. You can judge for yourself the effect from the examples
below which are real test data from a production computer power supply.
The figure to the right is the “slow” loop measured
at the top of R2. This is actual test data from a 5 V
power supply using a TL431 and optocoupler in the
feedback path. The loop crosses over about 60 Hz
with over 90 degrees of phase margin.

The figure to the right is the “fast” loop measured at
the top of R1. This is also actual test data from the
same 5 V power supply with the same TL431 and
optocoupler in the feedback loop. There is no gain
in this loop at low frequency because all the low
frequency gain comes from the “slow” loop. This
loop has a bandwidth of 6 kHz with about 90
degrees of phase margin.
This is the “Do Math on Data” window. To use this
window, first display both the “slow” loop and the
“fast” loop on the same graph. If you take the data on
one loop and then the other, they will both be on the
same graph. If not, you can do a cut and paste.

This is a graph with both the “slow” and “fast” loops
displayed, together with the results from the Double
to Single Loop conversion. The “slow” loop was
selected as Data Set 1 and the “fast” loop was
selected as Data Set 2. When the “Create” button is
clicked, the result of the calculation is displayed as
the loop resulting from the parallel combination of
the “slow” and “fast” loops.
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The graph at right is the total 5 V loop displayed
as a separate graph by copying the Data Set
from the previous graph and pasting it onto a new
graph. This loop crosses over at about 6 kHz
with about 85 degrees of phase margin. You can
read the exact values by adding a slide bar to the
Data Set and moving the slide bar to the unity
gain frequency of the loop. Once this loop is
calculated, the same process can be repeated
with the “slow” 12 V loop.
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Measurement of the Pieces of a Loop
One of the most powerful techniques for analyzing and evaluating a circuit is to model it
and then compare the model result with test results. Usually they will not match the first
time. If a circuit is complex, like the one below, the loop is made up of many pieces.
When the model and test results do not match, it is difficult to tell exactly which piece of
the loop is causing the problem. The way around this dilemma is to test each piece of
the loop separately, then compare test data from each piece of the circuit to the model
results for that equivalent piece. If the pieces match, the model is probably accurate for
that particular piece. If the pieces do not match, then you know which part of the model
needs to be improved upon. The circuit is never wrong, it does what it does. If the
model does not match, it is the model that needs fixing. It is possible that the circuit is
not designed or built correctly and both the circuit and the model have to be changed,
but an essential first step is to have the model results match the test data.
The loop in the
example to the
right is broken
into 6 pieces.
What you define
as a piece of the
loop is arbitrary,
but it is helpful
to break it up
into the smallest
functional blocks
that can be
conveniently
measured and
analyzed. One
thing not shown
on the above
diagram is the
signal injection
point. A typical
injection point
would be in the
trace where the
filtered output
voltage ties to
R5 and R7, but
you can inject
anywhere. The
FRA inputs are
connected to the input and output of the gain block being tested.
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The six pieces of the loop are:
1) The transconductance of the power stage from control voltage in to unfiltered DC
output current. The input is the compensation pin of the PWM integrated circuit and
the output is the current in the rectifier diode measured with a current probe.
2) The unfiltered DC output current to raw output voltage. The input is the current in
the rectifier diode measured with a current probe and the output is the voltage
across the first set of filter capacitors.
3) The raw output voltage to filtered output voltage. The input is the voltage across the
first set of filter capacitors and the output is the DC output voltage of the power
supply.
4) The filtered output voltage to current in the opto-coupler diode. The input is the DC
output voltage of the power supply and the output is the current in the opto-coupler
diode. This current can be measured with a current probe or by analyzer specific
techniques.
For models with floating inputs, such as the 350a/350b/220/250, 3120, 350c, 63xx,
74xx and 88xx analyzers, you can measure the voltage directly across R5, taking
advantage of the fact that the input channel returns of the Venable Models float.
For models 3215/3225/3235 you can measure the voltage directly across R5 using
channel 1 configured as a differential channel as long as the voltage doesn’t exceed
30 V on either input.
The input channel returns of the HP3577 and 43xx series analyzers are at ground so
the voltage across R5 can’t be directly measured with this analyzer unless you use
differential amplifier or probe connected to the input.

5) Current in the optocoupler diode to current in the optocoupler transistor. This is
called the current transfer ratio, CTR. It is constant at low frequency but rolls off at
high frequency. The input is the current in the optocoupler diode, measured as
described in block 4 above. The output is the current in the optocoupler transistor.
The output measurement requires a current probe, and most likely cutting a circuit
trace. It is not strictly necessary to measure this particular gain block, since all the
AC current through the transistor has to flow through the parallel combination of R1
and C1. The inverting input of the error amplifier is a virtual ground and no AC
current flows through R4. The reason you might want to make this particular
measurement is to be able to separate the parasitics of the optocoupler from the
parasitics of the error amplifier so you can make your model more accurate.
6) Current in the optocoupler transistor to control voltage out of the error amplifier. The
final block has the current in the optocoupler transistor as the input and the control
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voltage (output of the error amplifier) as the output. This gain should be just the
optocoupler transistor current times the parallel impedance of R1 and C1, but the
gain-bandwidth product of the error amplifier is often an important parasitic affecting
the gain of this particular block.
Some of these pieces require the use of a current probe. The output of a current probe
is not 1 volt per amp unless the current probe is set to the particular range that gives
this scale factor. You can use the “Scale Factor” provision of Data Set Properties to
scale the data for the particular current probe gain setting so that the output is always 1
amp per volt.
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Measurement of the Impedance of Components versus Frequency
There are two ways to measure impedance of components. We offer an RLC
measurement package that has a test fixture and special software to correct for
measurement fixture parasitics in real time as the measurements are being taken. This
is the first and easiest way to measure impedance of components.
The second way, the method described here, does not require any additional hardware
or software except a single resistor. Although, you can use our RLC text fixture if you
have one. It has the same connections as shown in the figure below. The ability to
measure and display impedance is a built-in feature of the Venable software package.
This includes the ability to measure parasitics of test fixtures. The Do Math on Data
window can be used to correct for test fixture parasitics. This procedure is not difficult
but it is not automatic the way it is in the RLC measurement package software.
Impedance is voltage divided by current. We use the oscillator output of the FRA as a
signal source. We connect the oscillator to the component under test, usually through a
series resistor. You can measure the current with a current probe, but it is usually
easier to take advantage of the floating inputs of the analyzers (except the HP3577) and
measure current by measuring the voltage
across the resistor in series with the component
under test. For the HP3577, you can use a
differential amp or an analyzer with floating
inputs to measure current by measuring the
voltage across the resistor in series with the
component under test. There is about 200 pF of
stray capacitance from return to chassis and
about 50 pF of capacitance from input to return
of the analyzer inputs. For this reason, we
usually connect the current measuring channel
(CH1) “backward”, so the return is connected to the oscillator output as shown in the
figure. This minimizes the parasitic capacitance across the component under test.
Let’s measure the impedance versus frequency of an electrolytic capacitor as an
example. The first thing to do is find a good resistor to sense the current. It should be
non-inductive, such as a film resistor. The value is not critical but a value around 100
ohms will give a good balance between the impedance being tested and the open circuit
and short circuit parasitic impedances. Although the particular value is not critical, it is
important to know the absolute value of the current measuring resistor. You should
measure the value with a good ohmmeter
before you start or use a resistor with a tight
tolerance.
Connect the oscillator output, channel 1 input,
and channel 2 input as shown in the figure
above or connect the RLC test fixture to the
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analyzer. Open the Venable System software and click on the Analyzer Control icon to
open the Analyzer Control window. Adjust the settings to match the sample screen on
the previous page. We used the maximum output voltage (10 V peak for Venable
models) to get the best accuracy and Medium integration time for the best speed
(100ms for 350a/350b/220/250 or AutoBandwidth for HP3577). Before starting the
sweep, make sure the graph screen displayed is a blank impedance plot. You can open
a new one when you click the New Graph icon or click File-New and then click on
Impedance and Phase plot. Then, after adjusting the Analyzer Control settings, click
the “Take Data at Start Freq.” button. When the analyzer has taken a few data points,
click the “Run Sweep” button.
A window will pop up displaying the
Output Node, Input Node, and Scale
Factor. If you made the same
connections as the test setup schematic
on the previous page or are using the
RLC test fixture, Output Node will be 2,
Input Node will be 1 (both default
values), but the Scale Factor has to be
changed to match the value of the
current sensing resistor. In this case,
with the current measuring channel connected “backward”, the polarity of CH1 will be
“backward” also. You correct this by entering the current sense resistor value as
negative. If you used 100 ohms to measure the current, enter the Scale Factor as –100
in the Data Set Properties dialog box as shown above. If you are using a current probe,
the Scale Factor is the Volts/Division divided by the Amps/Division of the current probe
amplifier. When you have changed the Scale Factor to match the current sensing
device and the circuit connection, click OK and the sweep will start. You may want to
move or minimize the Analyzer Control window so you can see the data being taken in
real time.
The graph does not
automatically autoscale
except for sweeping
beyond the current graph
frequency limit. When the
sweep is complete, you
can change the scale
manually by doubleclicking on any open area
of the graph, entering the
desired minimum and
maximum values, and
then clicking OK. You
can autoscale by clicking
the “Autoscale” box and
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then clicking OK. In the example shown, we were testing an aluminum electrolytic
capacitor with a rated voltage of 35 VDC and a nominal capacitance value of 200 μF.
We added slide bars to show the capacitance at 100 Hz (207.4 μF), the ESR when it is
purely resistive (84.48 milliohms), and the inductance at 1 MHz (93 nH).
The only problem with the graph on the preceding page is that the parasitics of the test
setup are not taken into account and may be significant at low or high impedance levels.
To check on this, let’s measure the parasitics. To do this, simply make the same
measurement as before, except do it with the Component Under Test being first an
open circuit and then a short circuit. Here are the results of those two measurements.
For clarity, the plot type is impedance only.
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The graph below shows the
result of using “Do Math on
Data” to subtract the
parasitic short circuit
impedance from the
capacitor impedance test
data. The impedance is too
far below the open circuit
impedance to require
compensation for open
circuit parasitics. The true
inductance of the capacitor
can be seen in the text box
near the slide bar to be
59.21 nH instead of the 93
nH we measured without
correcting for short circuit
parasitic impedance.
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The example on the previous pages was for measuring a low impedance and correcting
for short circuit parasitics by subtracting the short circuit impedance from the test data.
The same concept can be used for measuring high impedances and correcting for open
circuit parasitics, except it is a little trickier because the open circuit parasitics are in
parallel with the test data instead of in series.
The best way to illustrate the
difference is with an example.
Let’s say we want to measure a
10 pF capacitor. This is a lot
smaller than the parasitic
capacitance of approximately 60
pF for an Analyzer (30pF for the
HP3577) and the impedance of
a 10 pF capacitor is greater than
the parasitic resistance of 1
mega ohm for all frequencies
below 16 kHz. To do the test,
first connect the 10 pF capacitor
as the “Component Under Test” in the test setup on page 36 and run a sweep as before
choosing “Impedance and Phase” as the plot type. The Analyzer Control window is to
the right and the resulting plot with the scales changed to accommodate the data is
shown below. Choose “Impedance and Phase” as the graph type and choose Voltage
Node = 2, Current Node = 1, and Scale Factor = -100 if you are using a 100 ohm
resistor to measure the current and the connection is the same as the figure on page 47
or if you are using the RLC test fixture.
The graph to the right shows
the impedance versus
frequency plot of the 10 pF
capacitor together with the
parallel parasitic resistive
and capacitive admittance.
So far, it just looks like
1 mega ohm in parallel with
about 70 pF, but we would
like to look at the 10 pF
capacitor by itself, not in
parallel with all those
parasitic elements. To do
that, we need to run another
sweep and then use “Do
Math on Data” to fix the plot.
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Disconnect the 10 pF capacitor from the test setup but leave the 100 ohm resistor and
leave the oscillator and both voltmeters connected as before. Run a second sweep with
nothing connected except the
voltmeters. This is the open
circuit impedance plot.
There will not be much
difference between the two.
The graph to the right shows
both sets of data with the
open circuit parasitic data
highlighted (selected).
Now comes the tricky part.
What you want to do is
subtract the admittance of
the open circuit parasitics
from the admittance of the
test data (which includes the
impedance of the component
under test in parallel with the parasitic open circuit impedance). We have a feature in
“Do Math on Data” called “Subtract in Parallel”. This will put the negative of the
parasitic impedance in parallel with the test data, effectively canceling out the open
circuit parasitic impedance and yielding only the impedance of the component under
test.
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The plot on the upper right shows the results of the step on the previous page. The
highlighted curve is the result of doing a "Subtract in Parallel" of the test data with from
the parasitic data.
The graph below is the final
impedance versus frequency
graph of the 10 pF capacitor.
The impedance data is accurate
up to about 100 mega ohms.
Beyond that, the data is noisy
because the parasitic resistance
is only 1 mega ohm. At the
upper left corner of the graph we
are trying to resolve the
difference between 1 mega ohm
and 1 giga ohm in parallel with 1
mega ohm, and understandably
the result has a little variance
because we are approaching the
limits of measurement resolution.
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Measurement of the Input and Output Impedance of Power Supplies
With the Input/Output Impedance Test Set option of the Venable Instruments System,
you can measure input and output impedance of any power supply (or almost anything
else for that matter). The Input/Output Impedance Test Set consists of a high-power 4quadrant amplifier and power injection transformer. The injection transformer is capable
of handling large amounts of DC current while still coupling an AC signal into the circuit.
The standard power amplifier is rated 300 watts, and higher power ratings are available
on special request. The injection transformer is rated 50 or 100 amps DC depending on
model. Because the power amplifier is 4-quadrant, this system will also work for making
measurements with an AC power source instead of DC. Since AC load current is
transformed by the injection transformer and has to flow through the power amplifier,
check with us here at Venable Instruments before making high power AC
measurements to make sure the power amplifier is not overloaded and damaged. DC
measurements are safe up to the rated current of the injection transformer.
The test setup at the right
Frequency Response Analyzer
shows a general purpose
OSC
setup for measuring
CH1 CH2 CH3
impedance. If the “Source”
is truly a source and the
Power
Amplifier
“Load” is the Unit Under
Test, this setup will measure
Current
Probe
input impedance of the Unit
Injection
Under Test. As with
Transformer
component measurements,
Voltage
Source
Load
Voltage
impedance is voltage
divided by current. In the
test setup shown, source
output impedance is
CH3/CH1 and load input
Test setup for measuring input and output impedance.
impedance is CH2/CH1
noting that there may also have to be a scale factor if the output of the current probe
amplifier is not 1 volt per amp. If the “Load” is the Unit Under Test, CH2/CH1 is the
input impedance of the Unit Under Test.
If the “Source” is the Unit Under Test and the “Load” is an actual or simulated load, this
test setup will measure the output impedance of the Unit Under Test. CH3/CH1 is the
output impedance of the Unit Under Test. If your system does not have a channel 3,
then you must move CH2 to the source side of the injection transformer to measure the
output impedance of the Unit Under Test.
Current probes are directional. If the arrow on the current probe is pointing toward the
load, then the measured impedance of the load will be the correct polarity. The scale
factor of the data set will be the effective resistance of the current probe, which is the
rated volts per division of the current probe amplifier output (usually 0.01 volts per
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division) divided by the amps per division setting of the current probe amplifier. For
measuring the output impedance of the source, if the arrow on the current probe is
pointing toward the load (away from the source) then the scale factor will be the
negative of the value calculated above for the load input impedance data set. It is
important to pay attention to the direction of the current probe arrow, especially if you do
not have a feel for the expected phase of the test result readings.
Impedance measurements are a lot trickier than they look. The hardest part is getting
the current probe set up properly. The second hardest part is making sure the drive
levels are correct and nothing is being underdriven or overdriven. The third hardest part
is getting the scale factor and polarity correct.
Let’s start with the current probe. If you want good performance at low frequency,
choose a DC current probe such at the Tektronix AM503S System. The current probe
is not part of the Venable System or the Input/Output Impedance Test Set. It must be
purchased separately if you do not already have one. Models are available in 20, 100,
and 500 amp versions. Try to use one matched as closely as possible to the current
you plan to measure. Trying to measure a few milliamps with a 100 or 500 amp current
probe will not give very satisfactory results. The next thing to remember is that the
Tektronix current probe amplifier is made to work into a 50 ohm load. That means you
need to put a coaxial 50 ohm termination on each input of the FRA that is measuring
current. The termination goes on the frequency response analyzer end of the BNC
cable, not the current probe amplifier end. Make sure the termination is really 50 ohms
by checking it with a good ohmmeter. You would be amazed how many 50 ohm
terminations are “burned up” from connecting them to high-power sources. The
accuracy of the impedance measurement is dependent on the accuracy of the 50 ohm
termination. Failure to properly terminate the current probe is a common source of error
in impedance measurements. Once you have chosen a current probe of the correct
current rating and properly terminated it, the next area of concern is the range setting of
the current probe amplifier. The Tektronix current probe amplifier has a dynamic range
of about ±10 divisions. In other words, if you set the current probe amplifier to 1 amp
per division, it will read accurately up to about ±10 amps. In general, the measurements
we are making are on DC power lines. We are superimposing a small amount of AC
voltage in series with the DC output voltage of the source in order to make a small AC
deviation in the DC current being drawn or supplied. The current probe amplifier range
should be set so the DC current represents a large portion of the dynamic range but
does not exceed the dynamic range. For best accuracy, choose a range setting where
the DC current being sensed represents between 3 and 8 divisions. For example, if the
DC current is 3 amperes, the current probe amplifier setting can be 1 amp per division
(3 divisions) or 0.5 amps per division (6 divisions). Either setting will work and give
good sensitivity without saturating the current probe amplifier.
The next critical adjustment of a current probe amplifier is DC balance. The newer
current probe amplifiers are self-balancing, but older ones need to be adjusted so they
output 0 volts DC when there is no current flowing through the probe. A small amount
of DC error will not cause a problem since the FRA rejects DC, but if there is a large
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balance error it can affect the dynamic range of the amplifier and cause it to saturate
with less than 10 divisions of deflection. Current probes get “gaussed”, which means
that they have some residual flux in the core of the transformer used to sense current.
The DC balance adjustment corrects for this residual flux. Current probe amplifiers
have a “Degauss” button, which drives the internal transformer with a large amplitude
but exponentially decreasing AC excitation with the objective of minimizing the residual
flux in the transformer. After you “degauss” the current probe, you will have to readjust
the DC balance setting. The problem is that when you make another measurement, the
DC current flowing through the probe “gausses” the transformer again and it
immediately needs to be readjusted for DC balance. Our recommendation is to not
degauss the probe because you will only make it difficult to adjust the DC balance again
once you start taking measurements. One highly recommended step is to connect an
oscilloscope in parallel with the FRA input (after the 50 ohm termination) so you can see
the level of DC offset, the amount of deflection caused by the DC current, and the
amount of AC deviation superimposed on the DC current.
The final detail of using a current probe is to calculate the effective resistance of the
probe. If you used a resistor of value R to measure current, you would get R volts
across the resistor for every amp through it. The current probe has an effective
resistance, which is the number of volts out of the current probe amplifier for every amp
through the current probe. The Tektronix AM503 series of current probe amplifiers have
a fixed output of 0.01 volts for a unit of current equal to the range setting. The current
probe amplifier output is 0.01 volts per division and the range setting is given in amps
per division so the effective resistance of the current probe is 0.01 divided by the range
setting. If the amplifier is set to 10 milliamps (0.01 amps) per division, then the effective
resistance is 1 ohm. One common error in making impedance measurements is to
leave the current probe amplifier set to 10 milliamps per division no matter what current
is being measured. This simplifies the math, since there is no need to use the Scale
Factor provision of the testing and plotting software. It also means that often the current
probe will be operated far from its optimum range, sometimes even in the saturation
region where the output is no longer linearly proportional to the input. Failure to choose
the proper range is another common source of error in impedance measurements. That
about covers the common mistakes people make in the use of current probes.
Now let’s go to the subject of drive levels. There are two variables in setting the drive
level. One is the level of the Oscillator Output of the FRA; the other is the gain setting
of the power amplifier. Since the amplifier output is the product of these two gain
settings, there are an infinite number of gain setting possibilities for any given output
level. The simplest way to set the level is to use one of the gain variables to set the
injection transformer output level to the desired level at an intermediate frequency such
as 1 kHz and then leave the gain settings alone during the sweep. An effective way to
do this adjustment is to set the FRA Oscillator Output to a reasonable level like 1 volt
and then use a voltmeter or oscilloscope to monitor the output of the injection
transformer and adjust the gain knob on the power amplifier for the desired output
value. This can be done before power is applied; in fact it can be done before the
injection transformer is even connected into the circuit. For example, let’s say you are
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testing the impedance of some piece of the International Space Station. The Space
Station power bus is 120 VDC and program officials have decided that a 2% variation in
the power bus will not damage the equipment. That means that the 120 VDC bus can
vary by ±2.4 volts and still be in the safe region. You can set the analyzer AC Volts Out
to 1 volt peak. You can then monitor the output of the injection transformer and set the
gain control of the power amplifier for ±2 volts peak voltage at 1 kHz. This will give a
small margin of safety (from 2 volts to 2.4 volts). The amplitude of the oscillator output
is very flat with frequency. The gain of the power amplifier is also flat with frequency
except where the output falls off, below 10 Hz and above 100 kHz. This means that by
setting the amplitude in mid-range (1 kHz), the output amplitude will not exceed this
value at any time during the sweep.
When you plot the test results, the variable called Scale Factor on the Data Set
Properties window is the resistance used to measure the current or the effective
resistance of the current probe. The polarity will be correct if the current probe arrow is
pointing toward the Unit Under Test. If the current probe arrow is pointing away from
the Unit Under Test, the Scale Factor will have to be entered as a negative value.
The graph below is actual test data of the input impedance of one of the Orbital
Replacement Units of the International Space Station.
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Circuit Modeling Overview
Introduction

The Venable software contains a built-in circuit-modeling program. This program is
similar to SPICE in that it works from a net list. It is a relatively simple program. There
are no libraries of parts and only AC analysis is performed. The advantage of this
program is that it is very quick and easy to create and analyze models. It is easy to
create accurate models of actual circuits since it is so easy to compare the model
results with actual test results and also easy to change the model to make the model
data match the test data.
We recognize that keying in a few lines of circuit description is not as glamorous as
entering data with a schematic entry program, but we think you will find this method
quicker and easier once you get used to it.

The following components are available:

V
I
R
L
C
G

Voltage source (volts)
Current source (amps)
Resistor (ohms)
Inductor (henries)
Capacitor (farads)
Conductance (mhos)

You can add annotation after any component designator. V, V213, or Vemf all will be
interpreted as a voltage source.

The following abbreviations can be used for multipliers:

p or
n or
u or
m
k or
M
g or
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P
N
U
K
G

multiplied by 1E-12
multiplied by 1E-9
multiplied by 1E-6
multiplied by 1E-3
multiplied by 1E+3
multiplied by 1E+6
multiplied by 1E+9
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The format of a source is:
Type of source
Resistance

positive control
node
positive connection
node

negative control
node
negative connection
node

value or gain
value

A special case is using 0 for both control nodes; this indicates a fixed source.
Spaces or commas separate entries.
R1

Node 1

50 Ohm

Example 1: Voltage Source
V1

1V

V 0 0 1
R 1 0 50

Node 0

This is a fixed 1-volt source with an impedance of 50 ohms, connected in the circuit
from node 1 (positive node) to node 0 (negative node). Node 0 is always circuit
common.
Node 3

Node 2
(+)

Example 2: Current Source

Node 4

I1

(-)

I 3 4 0.1

R4
1.5 K

R1
0.1 A
1M

R3
1.5 K

R 2 0 1M

Node 0

This is a current source controlled by the voltage from node 3 to node 4. It has a gain of
0.1, which means 1 volt from node 3 to node 4 will produce 0.1 amp from this source. It
is connected in the circuit from node 2 to node 0, and is paralleled by a 1 mega-ohm
resistor. Node 2 is in phase with node 3.

The format of a component is:
Component type

connection node

connection node

value

Example 3: Component (in this case, a capacitor)

C13 4 3 10U
This is a capacitor connected from node 4 to node 3 with a value of 10 microfarads.
The order of the connection nodes is not significant. The number "13" after the C is any
desired notation to identify the component, usually the reference designator.
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Notes on model file creation:

Model files are ordinary ASCII text files. They can be created with any ASCII editing
program such as Notepad in Windows.
Model files can have any extension, but if they have no extension a .CKT extension will
be added when the circuit is saved.
Comment lines can be added at the beginning of a file by beginning each line with an
asterisk.
Comments can be added at the end of any line. It is not necessary to begin a comment
with an asterisk. The program will ignore anything on a line after reading the required
four entries.
Blank lines are ignored.
Circuit node numbers must be sequential. They do not have to be entered in sequence,
but all nodes from 0 to the highest number node must be present. A missing node
number will generate an error.
Example 4: Circuit file for a low-pass filter
Node 2

Node 1

*Low-pass R-C filter

R1

R2

V1 0 0 1

1

1K

R1 1 0 1

V1

1V

0.1 U

C1

R2 1 2 1K
C1 2 0 0.1U

Node 0

This circuit file represents a fixed one-volt source with a source impedance of 1 ohm
driving a low-pass filter consisting of a 1,000 ohm resistor in series with a 0.1 microfarad
capacitor to ground. When analyzed and plotted as the transfer function (Bode plot)
from node 1 to node 2, the result will be a classic low-pass filter response. Since the
result is plotted as the ratio of the voltage on node 2 divided by the voltage on node 1,
the impedance of the source (1 ohm) does not enter into the calculation and the result
will be the same no matter what the value of the source resistance.

05/21/19

93

Example 5: Measuring the output impedance of an input filter

*Model of input filter output impedance
V1 3 2 10
Controlled source translates current to ground reference. Gain=1/R3.
R1 1 0 1
Resistance of controlled source (value not significant)
V2 0 0 1
Fixed one volt source driving output of filter
R2 3 0 1
Impedance of test source (value not significant)
R3 3 2 0.1
Resistor to measure current. Different value changes gain of V1.
C1 2 4 100U Output capacitance of L-C filter
R4 4 0 0.01 ESR of filter output capacitor
R5 2 5 2
Damping resistor
C2 5 0 390U Capacitor to block DC current through damping resistor
L1 2 6 100U Input inductance of L-C filter
R6 6 0 0.01 Resistance of input inductor
Node 6

L1

Node 2

R3

100 U

0.1
R5

R6

0.01

Node 3

2

C1

Node 5
C1

1

Node 1

1

100 U
Node 4

390 U R4

R1

R2

V2

1V

V1

Gain = 10

0.01

Node 0

Normally R3 would be 1 ohm to simplify the calculation, and V1 would have a gain of 1.
The values used in this example show the flexibility of the technique.
R6 is connected to ground to represent zero AC impedance of the power source.
In this example, filter impedance is measured as Node 2 over Node 1.
Note that the Venable system, unlike older Spice-type modeling programs, actually plots
the ratio of the output to the input. Many older modeling programs require a one-volt
source as an input and then plot absolute value of the output and pretend it is the ratio
of output to input. This works when the input is exactly one volt, but the technique falls
apart when the input is not one volt. When measuring gain by plotting the ratio of
voltages on each side of an injection resistor, the capability to plot voltage ratios is
essential.
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APPENDIX A
“Option” Selection for model series 43xx/63xx/74xx/88xx/350c

The “Option” selection on the analyzer control menu for these analyzers, provide special
capabilities and/or algorithms to be utilized during analysis under conditions that require
them. Each option is toggled ON or OFF each time the option is selected. New
capabilities and algorithms will be added to the option list as they are developed and
become available by Venable Industries. These new options will be provided through
firmware updates for the Venable Analyzer and updates to the Venable software.
Details for each option is described below.
350b Operating Mode

This setting enables or disables continuous sine wave output through a
measurement sweep. This provides analyzer operation identical to the legacy
Venable 350 analyzers. This function is not compatible with the Digital Interface
function. “Circuit under Test” must be set to DC to utilize this function.
Sync Output

This setting activates or deactivates the sync output on the back panel of the
analyzer. The output produces a square wave signal that is frequency and phase
locked to the generator output.
Digital Interface

This setting enables or disables the Digital I/O port on the 88xx series of analyzers.
When the setting is turned OFF, the analyzer operates as a standard 2 channel
analog analyzer. This function is not compatible with the 350b Operating Mode.
High Noise Algorithm

This setting engages algorithms within the analyzer itself, to provide improved
results when connected to units under test that have high levels of noise inherent
in them. This is typically when the noise voltage levels are more than 10X the
injection voltage. Applications that do not experience these levels of noise
should not use this mode. This algorithm generally increases bias elimination
times and adjusts the criteria for auto-ranging to determine the most suitable range
for analysis to provide better results. Integration time selection are not affected by
this algorithm, however the user should expected much longer processing times to
occur between frequency points.
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“Circuit Under Test” Selection for model series 43xx/63xx/74xx/88xx/350c

Sets the operational state of the instrument to optimize its operation when channel
inputs are attached to an AC environment. The user can select the line frequency (Hz)
of the environment that the analyzer channels are being attached to. For measurement
of DC power supplies, this selection should remain set to DC. When the 350b Operating
Mode in active, only DC mode is allowed.
Notes: This capability is available in the following application firmware versions only:
Version 1.x:
Version 2.x:
Version 3.x:
Version 4.x:
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version 1.7 or later
version 2.5 or later
version 3.3 or later
All
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APPENDIX B
Calibration Specifications for 5140, 63xx, 74xx, 88xx & 350c Analyzers
Generator Output Tests: Test 10

DC Bias:

Resolution:
Accuracy:

10mV
+/- 1.0% of Range Full Scale (10VDC)

Square Wave Accuracy: +/- 1.0% of Range Full Scale (all ranges except 10mV)
+/- 1.5% of Range Full Scale (10mV range only)
Output ranges
Range
10 mVpk
31.6 mVpk
100 mVpk
316 mVpk
1 Vpk
3.16 Vpk
10 Vpk

Sine Wave AC Amplitude Accuracy:
+/-(1.0% + 1%/MHz) of Range Full Scale (all ranges except 10mV & 30mV)
+/-(1.8% + 1%/MHz) of Range Full Scale (30mV range only)
+/-(2.6% + 1%/MHz) of Range Full Scale (10mV range only)
Resolution: Depends on the range setting (see table below)
Output ranges and resolution
Range
Sensitivity
10 mVpk
10uV
31.6 mVpk
30uV
100 mVpk
100uV
316 mVpk
300uV
1 Vpk
1 mV
3.16 Vpk
3 mV
10 Vpk
10 mV
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Channel Input Tests

Amplitude Accuracy: Tests 20 - 26
>= 1 MHz: +/- (1.0% + 1.3%/MHz) of Range Full Scale (all ranges)
< 1 MHz: +/- (0.4% + 1.3%/MHz) of Range Full Scale (all ranges except 10mV)
< 1 MHz: +/- (0.6% + 1.6%/MHz) of Range Full Scale (10mV range only)
Output ranges
Range
10 mVpk
31.6 mVpk
100 mVpk
316 mVpk
1 Vpk
3.16 Vpk
10 Vpk
31.6 Vpk
100 Vpk
316 Vpk
500 Vpk

Phase Accuracy: Tests 30 - 59
+/- (0.4deg + 1.0 deg/MHz)

Bandwidth Accuracy: Tests 60 - 65
Amplitude: +/- (0.04 dB + 0.1 dB /MHz)
Phase:
+/- (0.4 deg + 1.0 deg/MHz)
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RLC Specifications
Measurement Frequency

1 Hz to 40 MHz, user-selectable for single component, selected automatically for
multiple-component circuit.
Accuracy

1 Hz to 1 kHz
1 kHz to 100 kHz
100 kHz to 1 MHz
1 MHz to 10 MHz
10 MHz to 40 MHz

0.1%
0.2%
0.5%
1.0%
4.0%

Optimum Measurement Range

Resistance:
Inductance:
Capacitance:

10 milliohms to 1 megaohm
1 microhenry to 10,000 henries
100 picofarads to 1 farad

Extended Measurement Range*

Resistance:
Inductance:
Capacitance:

100 micro-ohms to 100 megaohms
10 nanohenrys to 1 megahenry
1 picofarad to 100 farads

* Extended range loses least-significant digit of accuracy for each decade of measured
value outside the optimum measurement or frequency range.
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Specifications:

Venable 350c, 3 channel, 5, 20, and 40MHz Models

Generator:
Frequency Range:
AC Amplitude
DC Bias
Sweep Modes:

Output Amplitude
Compression:
Output Impedance:
Output Configuration:

10µHz to 5, 20, or 40MHz (sine wave)
10µHz to 1MHz (square wave)
1mV to 10V
±10V, 10mV Steps
Single Frequency, logarithmic and linear sweep steps
Log Sweep: 0.1 – 2000 Steps per decade
Linear Sweep: 1Hz – 5, 20, or 40MHz step
Dynamically adjust output to maintain a constant channel input level
through Venable software servo
Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz
Single-ended floating and isolated up to ±600 Vpk

Analyzer:
Frequency Range:
Input Configuration:
Input Impedance:
Measurement Accuracy:
Measurement Technique:

Input Coupling:
Input Range:
Dynamic Range:
CMRR/IMRR:
Max. Input:
Max Input Withstand Voltage:
Over-range Alarms:
Calibration:

10µHz to 5, 20, or 40MHz
Ch.1, 2, and 3: Single-ended Floating to ±600Vpk
Switchable: 50 Ohms or 1 Mega Ohm (default)
± 0.03dB + .1dB/MHz;
± 0.4deg + 1deg/MHz
Narrowband DFT
Integration Time: 20msec to 100ksec
Delay Time: 0-100ksec
Integration Cycles: 1-9999 cycles
Delay Cycles: 1-9999 cycles
DC with automatic DC offset cancellation
10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging
120 dB
120 dB
±500Vpk
±600Vpk
LED indicator
NIST and Z540.1 standards

System:
PC Interface:
Auxiliary Output:
Application software:
Real time display update:
Data Analysis:

Power Supply Requirements:
Weight/Dimensions:
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USB 2.0 and IEEE 488 (GPIB)
12Vdc @ 400mA, 4.8W for accessories
Venable Stability Analysis™ for Win 7/8/10
Each point is plotted as acquired
Polar coordinates: Gain magnitude, Phase, Gain margin, and phase
margin
Impedance: R, L, C, Z magnitude, and Phase
90 to 264Vac, 48 to 62Hz, 30VA,
12 Lbs. / 17”x 10”x 3.5”
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Specifications:

Venable 5140, 2 channel, 40MHz

Generator:
Frequency Range:
AC Amplitude
DC Bias
Sweep Modes:

Output Amplitude
Compression:
Output Impedance:
Output Configuration:

1Hz to 40MHz (sine wave)
10mV to 10V
±10V, 10mV Steps
Single Frequency, logarithmic and linear sweep steps
Log Sweep: 0.1 – 2000 Steps per decade
Linear Sweep: 1Hz – 40MHz step
Dynamically adjust output to maintain a constant channel input level
through Venable software servo
50 ohms
Single-ended grounded

Analyzer:
Frequency Range:
Input Configuration:
Input Impedance:
Measurement Accuracy:
Measurement Technique:

Input Coupling:
Input Range:
Dynamic Range:
CMRR/IMRR:
Max. Input:
Max Input Withstand Voltage:
Over-range Alarms:
Calibration:

1Hz to 40MHz
Ch.1: Single-ended Floating to ±600Vpk
Ch.2: Single-ended grounded
1 Mega ohm
± 0.03dB + .1dB/MHz;
± 0.4deg + 1deg/MHz
Narrowband DFT
Integration Time: 20msec to 100ksec
Delay Time: 0-100 sec
Integration Cycles: 1-9999 cycles
Delay Cycles: 1-9999 cycles
DC with automatic DC offset cancellation
10mV to 10Vpk Full Scale in 7 ranges, Auto-ranging
120 dB
120 dB
±100Vpk
±100Vpk
LED indicator
NIST Standard

System:
PC Interface:
Auxiliary Output:
Application software:
Real time display update:
Data Analysis:

Power Supply Requirements:
Weight/Dimensions:
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USB 2.0
12Vdc @ 400mA, 4.8W for accessories
Venable Stability Analysis™ for Win 7/8/10
Each point is plotted as acquired
Polar coordinates: Gain magnitude, Phase, Gain margin, and phase
margin
Impedance: R, L, C, Z magnitude, and Phase
90 to 264Vac, 48 to 62Hz, 30VA,
24VDC, 24W (Min)
4 Lbs. / 9.8”x 9.8”x 3.2”
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Specifications:

Venable 63XX, 2 channel, 5, 20, and 40MHz Models

Generator:
Frequency Range:
AC Amplitude
DC Bias
Sweep Modes:

Output Amplitude
Compression:
Output Impedance:
Output Configuration:

10µHz to 5, 20, or 40MHz (sine wave)
10µHz to 1MHz (square wave)
1mV to 10V
±10V, 10mV Steps
Single Frequency, logarithmic and linear sweep steps
Log Sweep: 0.1 – 2000 Steps per decade
Linear Sweep: 1Hz – 5, 20, or 40MHz step
Dynamically adjust output to maintain a constant channel input level
through Venable software servo
Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz
Single-ended floating and isolated up to ±600 Vpk

Analyzer:
Frequency Range:
Input Configuration:
Input Impedance:
Measurement Accuracy:
Measurement Technique:

Input Coupling:
Input Range:
Dynamic Range:
CMRR/IMRR:
Max. Input:
Max Input Withstand Voltage:
Over-range Alarms:
Calibration:

10µHz to 5, 20, or 40MHz
Ch.1 and 2: Single-ended Floating to ±600Vpk
Switchable: 50 Ohms or 1 Mega Ohm (default)
± 0.03dB + .1dB/MHz;
± 0.4deg + 1deg/MHz
Narrowband DFT
Integration Time: 20msec to 100ksec
Delay Time: 0-100ksec
Integration Cycles: 1-9999 cycles
Delay Cycles: 1-9999 cycles
DC with automatic DC offset cancellation
10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging
120 dB
120 dB
±500Vpk
±600Vpk
LED indicator
NIST and Z540.1 standards

System:
PC Interface:
Auxiliary Output:
Application software:
Real time display update:
Data Analysis:

Power Supply Requirements:
Weight/Dimensions:

05/21/19

USB 2.0 and IEEE 488 (GPIB)
12Vdc @ 400mA, 4.8W for accessories
Venable Stability Analysis™ for Win 7/8/10
Each point is plotted as acquired
Polar coordinates: Gain magnitude, Phase, Gain margin, and phase
margin
Impedance: R, L, C, Z magnitude, and Phase
90 to 264Vac, 48 to 62Hz, 30VA,
12 Lbs. / 17”x 10”x 3.5”
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Specifications:

Venable 74XX, 4 channel, 5, 20, and 40MHz Models

Generator:
Frequency Range:
AC Amplitude
DC Bias
Sweep Modes:

Output Amplitude
Compression:
Output Impedance:
Output Configuration:

10µHz to 5, 20, or 40MHz (sine wave)
10µHz to 1MHz (square wave)
1mV to 10V
±10V, 10mV Steps
Single Frequency, logarithmic and linear sweep steps
Log Sweep: 0.1 – 2000 Steps per decade
Linear Sweep: 1Hz – 5, 20, or 40MHz step
Dynamically adjust output to maintain a constant channel input level
through Venable software servo
Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz
Single-ended floating and isolated up to ±600 Vpk

Analyzer:
Frequency Range:
Input Configuration:
Input Impedance:
Measurement Accuracy:
Measurement Technique:

Input Coupling:
Input Range:
Dynamic Range:
CMRR/IMRR:
Max. Input:
Max Input Withstand Voltage:
Over-range Alarms:
Calibration:

10µHz to 5, 20, or 40MHz
Ch.1, 2, 3 and 4: Single-ended Floating to ±600Vpk
Switchable: 50 Ohms or 1 Mega Ohm (default)
± 0.03dB + .1dB/MHz;
± 0.4deg + 1deg/MHz
Narrowband DFT
Integration Time: 20msec to 100ksec
Delay Time: 0-100ksec
Integration Cycles: 1-9999 cycles
Delay Cycles: 1-9999 cycles
DC with automatic DC offset cancellation
10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging
120 dB
120 dB
±500Vpk
±600Vpk
LED indicator
NIST and Z540.1 standards

System:
PC Interface:
Auxiliary Output:
Application software:
Real time display update:
Data Analysis:

Power Supply Requirements:
Weight/Dimensions:

05/21/19

USB 2.0 and IEEE 488 (GPIB)
12Vdc @ 400mA, 4.8W for accessories
Venable Stability Analysis™ for Win 7/8/10
Each point is plotted as acquired
Polar coordinates: Gain magnitude, Phase, Gain margin, and phase
margin
Impedance: R, L, C, Z magnitude, and Phase
90 to 264Vac, 48 to 62Hz, 30VA,
12 Lbs. / 17”x 10”x 3.5”
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Specifications:

Venable 88XX, 23 channel, 5, 20, and 40MHz Models

Generator:
Frequency Range:
AC Amplitude
DC Bias
Sweep Modes:

Output Amplitude
Compression:
Output Impedance:
Output Configuration:

10µHz to 5, 20, or 40MHz (sine wave)
10µHz to 5MHz (square wave)
1mV to 10V
±10V, 10mV Steps
Single Frequency, logarithmic and linear sweep steps
Log Sweep: 0.1 – 2000 Steps per decade
Linear Sweep: 1Hz – 5, 20, or 40MHz step
Dynamically adjust output to maintain a constant channel input level
through Venable software servo
Switchable: 50 ohms (default) or high current 2 ohms to 5 MHz
Single-ended floating and isolated up to ±600 Vpk

Analyzer:
Frequency Range:
Input Configuration:
Input Impedance:
Measurement Accuracy:
Measurement Technique:

Input Coupling:
Input Range:
Dynamic Range:
CMRR/IMRR:
Max. Input:
Max Input Withstand Voltage:
Over-range Alarms:
Calibration:

10µHz to 5, 20, or 40MHz
Ch.1 and 2: Single-ended Floating to ±600Vpk
Switchable: 50 Ohms or 1 Mega Ohm (default)
± 0.03dB + .1dB/MHz;
± 0.4deg + 1deg/MHz
Narrowband DFT
Integration Time: 20msec to 100ksec
Delay Time: 0-999 sec
Integration Cycles: 1-9999 cycles
Delay Cycles: 1-9999 cycles
DC with automatic DC offset cancellation
10mV to 500Vpk Full Scale in 11 ranges, Auto-ranging
120 dB
120 dB
±500Vpk
±600Vpk
LED indicator
NIST and Z540.1 standards

Digital Analyzer:
Frequency Range:
Integration Cycles:
Interface:
Supported Processors:

10mHz to 1MHz
1-10 cycles
I2C and Sync Out (3.3V)
Contact Venable

System:
PC Interface:
Auxiliary Output:
Application software:
Real time display update:
05/21/19

USB 2.0 and IEEE 488 (GPIB)
12Vdc @ 400mA, 4.8W for accessories
Venable Stability Analysis™ for Win 7/8/10
Each point is plotted as acquired
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System: (cont.)
Data Analysis:

Power Supply Requirements:
Weight/Dimensions:

05/21/19

Polar coordinates: Gain magnitude, Phase, Gain margin, and phase
margin
Impedance: R, L, C, Z magnitude, and Phase
90 to 264Vac, 48 to 62Hz, 30VA,
12 Lbs. / 17”x 10”x 3.5”
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APPENDIX C
Hardware Description of 5140, 63xx, 74xx, 88xx & 350c Analyzers
350C Front Panel

Description
1. Power LED:
2. Auxiliary Power Jack:
3. Generator LED:

4. Channel LED:

5. Power Switch:
6. Generator Output:

7. Reference Channel:
8. Input Channels:

05/21/19

This amber LED Illuminates when the power is turned on.
Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box.
This green LED will flash on and off when power is turned on.
It illuminates when the generator is turned on by the user.
Normally it is off.
This green LED will flash on and off when power is turned on. The
green LED illuminates when the analyzer has finished booting
up and indicates that the channel ready for measurements.
Normally it is on. A flickering LED indicates that the channel is
overloading and trying to clear the overload. If it is off, the
channel is malfunctioning or can’t clear the overload.
This switch turns the analyzer on and off.
This is a floating single-ended output. .The output impedance is switchable
between 50 Ohms and 2 Ohms (high current). It is isolated and floats to
±600Vpk.
This channel is not used for measurement. It is used to measure the
oscillator output.
All three channels have single-ended floating inputs switchable between
input impedances of 50 Ohms and 1 Mega Ohm (default). They are
isolated and float to ±600Vpk.
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350C/63XX/74XX/88XX Rear Panel

Description
1. USB Port:

2. Ethernet Port
3. RS-485 Port
4. Sync Output
5. Modulator Input
6. Fuse
7. GPIB Port:
8. Accessories Port:
9. Chassis Ground:
10. Power Inlet:

05/21/19

Provides USB 2.0 communication with the Venable software version 5
using the Keysight VISA or Venable software version 6 using the Windows
USB driver (Win 7 and above).
This port is primarily used to upgrade the analyzer firmware.
Not implemented.
Outputs a CMOS level square wave signal set to the same frequency as
the generator output.
Not implemented.
Fuse holder for 1A/250 slow-blow fuse.
Provides IEEE 488 communication for Venable software and test
systems.
DB25 connector to control external accessories and the
automated calibration test fixture.
Ground terminal that works with bare wire, lugs or banana plug
Supplies the required 90 to 264Vac, 48 to 62Hz, and 30VA power to
the analyzer.
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5140 Front Panel

Description
1. Power LED:
2. Auxiliary Power Jack:
3. Generator LED:
4. Channel LED:

5. Power Switch:
6. Generator Output:
7. Channel 1 Input:
8. Channel 2 Input:

05/21/19

This amber LED Illuminates when the power is turned on.
Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box.
This green LED will flash on and off when power is turned on. It illuminates
when the generator is turned on by the user. Normally it is off.
This green LED will flash on and off when power is turned on. The green
LED illuminates when the analyzer has finished booting up and indicates
that the channel ready for measurements. Normally it is on. A flickering
LED indicates that the channel is overloading and trying to clear the
overload. If it is off, the channel is malfunctioning or can’t clear the
overload.
This switch turns the analyzer on and off.
This is a grounded single-ended 50 Ohm output. It requires that an
injection transformer be used when measuring feedback loops.
This is a single-ended floating 1 Mega Ohm input. It is isolated and floats
to ±600Vpk.
This is a grounded single-ended 1 Mega Ohm input
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5140 Rear Panel

Description
9. Chassis Ground:
10. Ethernet Port:
11. USB Port:
12. Accessories Port:
13. GPIB Port:
14. DC Power Inlet:

05/21/19

Ground terminal that works with bare wire, lugs or banana plug.
This port is primarily used to upgrade analyzer firmware.
Provides USB 2.0 communication with the Venable software version 6
using the Windows USB driver (Win 7 and above).
DB25 connector to control external accessories and the
automated calibration test fixture.
Provides IEEE 488 communication for test systems.
Supplies the required 24VDC voltage and 24W (Min) power to the
analyzer.
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63XX Front Panel

Description
1. Power LED:
2. Auxiliary Power Jack:
3. Generator LED:

4. Channel LED:

5. Power Switch:
6. Generator Output:

7. Input Channels:

05/21/19

This amber LED Illuminates when the power is turned on.
Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box.
This green LED will flash on and off when power is turned on.
It illuminates when the generator is turned on by the user.
Normally it is off.
This green LED will flash on and off when power is turned on. The
green LED illuminates when the analyzer has finished booting
up and indicates that the channel ready for measurements.
Normally it is on. A flickering LED indicates that the channel is
overloading and trying to clear the overload. If it is off, the
channel is malfunctioning or can’t clear the overload.
This switch turns the analyzer on and off.
This is a floating single-ended output. .The output impedance is switchable
between 50 Ohms and 2 Ohms (high current). It is isolated and floats to
±600Vpk.
Both channels have single-ended floating inputs switchable between input
impedances of 50 Ohms and 1 Mega Ohm (default). They are isolated and
float to ±600Vpk.
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74XX Front Panel

Description
1. Power LED:
2. Auxiliary Power Jack:
3. Generator LED:

4. Channel LED:

5. Power Switch:
6. Generator Output:

7. Input Channels:

05/21/19

This amber LED Illuminates when the power is turned on.
Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box.
This green LED will flash on and off when power is turned on.
It illuminates when the generator is turned on by the user.
Normally it is off.
This green LED will flash on and off when power is turned on. The
green LED illuminates when the analyzer has finished booting
up and indicates that the channel ready for measurements.
Normally it is on. A flickering LED indicates that the channel is
overloading and trying to clear the overload. If it is off, the
channel is malfunctioning or can’t clear the overload.
This switch turns the analyzer on and off.
This is a floating single-ended output. .The output impedance is switchable
between 50 Ohms and 2 Ohms (high current). It is isolated and floats to
±600Vpk.
All four channels have single-ended floating inputs switchable between
input impedances of 50 Ohms and 1 Mega Ohm (default). They are
isolated and float to ±600Vpk.
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88XX Front Panel

Description
1. Power LED:
2. Auxiliary Power Jack:
3. Generator LED:

4. Channel LED:

5. Power Switch:
6. Generator Output:

7. Input Channels:

8. Digital I/O Port:

05/21/19

This amber LED Illuminates when the power is turned on.
Provides 12Vdc@400mA, 4.8W for accessories such as the LF Bode Box.
This green LED will flash on and off when power is turned on.
It illuminates when the generator is turned on by the user.
Normally it is off.
This green LED will flash on and off when power is turned on. The
green LED illuminates when the analyzer has finished booting
up and indicates that the channel ready for measurements.
Normally it is on. A flickering LED indicates that the channel is
overloading and trying to clear the overload. If it is off, the
channel is malfunctioning or can’t clear the overload.
This switch turns the analyzer on and off.
This is a floating single-ended output. .The output impedance is switchable
between 50 Ohms and 2 Ohms (high current). It is isolated and floats to
±600Vpk.
Both analog channels have single-ended floating inputs switchable
between input impedances of 50 Ohms and 1 Mega Ohm (default). They
are isolated and float to ±600Vpk.
This port used to connect to a target processor in a digital power supply.
A special cable is used and the connection consists of an I2C bus, a sync
signal and a ground.
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